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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.

Documentation disclaimer
“Documentation” means information published in varying mediums
which may include product information, operating instructions and
performance specifications that are generally made available to users
of products. Documentation does not include marketing materials.
Avaya shall not be responsible for any modifications, additions, or
deletions to the original published version of Documentation unless
such modifications, additions, or deletions were performed by or on
the express behalf of Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all
claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.

Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.

Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.

“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription, the
foregoing limited warranty may not apply but You may be entitled to
support services in connection with the Hosted Service as described
further in your service description documents for the applicable
Hosted Service. Contact Avaya or Avaya Channel Partner (as
applicable) for more information.

Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO
UNDER THE LINK “Avaya Terms of Use for Hosted Services” OR
SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE
TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR

IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.

Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN
AVAYA AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License. The
applicable number of licenses and units of capacity for which the
license is granted will be one (1), unless a different number of
licenses or units of capacity is specified in the documentation or other
materials available to You. “Software” means computer programs in
object code, provided by Avaya or an Avaya Channel Partner,
whether as stand-alone products, pre-installed on hardware products,
and any upgrades, updates, patches, bug fixes, or modified versions
thereto. “Designated Processor” means a single stand-alone
computing device. “Server” means a Designated Processor that
hosts a software application to be accessed by multiple users.
“Instance” means a single copy of the Software executing at a
particular time: (i) on one physical machine; or (ii) on one deployed
software virtual machine (“VM”) or similar deployment.

License type(s)
Designated System(s) License (DS). End User may install and use
each copy or an Instance of the Software only on a number of
Designated Processors up to the number indicated in the order.
Avaya may require the Designated Processor(s) to be identified in
the order by type, serial number, feature key, Instance, location or
other specific designation, or to be provided by End User to Avaya
through electronic means established by Avaya specifically for this
purpose.

Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time. A “Unit” means the unit on which
Avaya, at its sole discretion, bases the pricing of its licenses and can
be, without limitation, an agent, port or user, an e-mail or voice mail
account in the name of a person or corporate function (e.g.,
webmaster or helpdesk), or a directory entry in the administrative
database utilized by the Software that permits one user to interface
with the Software. Units may be linked to a specific, identified Server
or an Instance of the Software.

Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/LicenseInfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For

https://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
https://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
https://support.avaya.com/LicenseInfo
https://support.avaya.com/LicenseInfo
https://support.avaya.com/LicenseInfo


Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.

Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.

Virtualization
The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Note that
each Instance of a product must be separately licensed and ordered.
For example, if the end user customer or Avaya Channel Partner
would like to install two Instances of the same type of products, then
two products of that type must be ordered.

Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.

The following applies only if the H.264 (AVC) codec is distributed with
the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG
LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM.

Service Provider
THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY
FROM THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL
PARTNER’S HOSTING OF AVAYA PRODUCTS MUST BE
AUTHORIZED IN WRITING BY AVAYA AND IF THOSE HOSTED
PRODUCTS USE OR EMBED CERTAIN THIRD PARTY
SOFTWARE, INCLUDING BUT NOT LIMITED TO MICROSOFT
SOFTWARE OR CODECS, THE AVAYA CHANNEL PARTNER IS

REQUIRED TO INDEPENDENTLY OBTAIN ANY APPLICABLE
LICENSE AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S
EXPENSE, DIRECTLY FROM THE APPLICABLE THIRD PARTY
SUPPLIER.

WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE G.729 CODEC, H.264 CODEC, OR H.265 CODEC, THE
AVAYA CHANNEL PARTNER ACKNOWLEDGES AND AGREES
THE AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY
AND ALL RELATED FEES AND/OR ROYALTIES. THE G.729
CODEC IS LICENSED BY SIPRO LAB TELECOM INC. SEE 
WWW.SIPRO.COM/CONTACT.HTML. THE H.264 (AVC) CODEC IS
LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR
THE PERSONAL USE OF A CONSUMER OR OTHER USES IN
WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I)
ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD
(“AVC VIDEO”) AND/OR (II) DECODE AVC VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN A PERSONAL
ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED
OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL
INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) CODECS
MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.

Compliance with Laws
You acknowledge and agree that it is Your responsibility for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.

Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.

Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.

Security Vulnerabilities
Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.

Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).

Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, its licensors, its suppliers, or other third parties. Users are
not permitted to use such Marks without prior written consent from
Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.

Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.

https://support.avaya.com
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Chapter 1: Introduction

Purpose
The purpose of this guide is to provide information about Avaya Aura® Call Center Elite Multichannel
Desktop and also how to use the application to receive, view, and respond to voice and multimedia
work items.

This guide is intended primarily for contact center agents who use Call Center Elite Multichannel
Desktop to receive voice and multimedia work items.

July 2016 Avaya Aura® Call Center Elite Multichannel Desktop User Guide 10
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Aura® Call Center Elite Multichannel Desktop User Guide


Chapter 2: Overview

Call Center Elite Multichannel Desktop, a flagship desktop application of Avaya, is designed and
developed for ease of operation in contact centers. The application presents voice and multimedia
work items to an agent.

The architecture of Call Center Elite Multichannel Desktop is based on the integration and
interaction of various plug-ins. This helps agents to perform all agent-specific operations on a single
desktop screen.

As an agent, without leaving the screen, you can:

• Receive and reply to work items from customers who make contact using:

- Telephone

- Email

- Web Chat

- Google Hangouts

- Simple Message Service (SMS)

• Record notes related to a work item or a call session.

• View the conversation history of a customer that you are handling.

• Search the directory for a phone number or an email address.

• View the real time statistical information about your work performance.

• Monitor the telephone activity of other agents in a contact center with whom you work closely.

• Handle work items efficiently by using the autotext, spell checker, and printing options in Call
Center Elite Multichannel Desktop.

Additionally, you can access external applications, such as Microsoft Internet Explorer within the
Desktop interface so that you do not have to minimize the Desktop application window. You can
also configure the application to start external applications in a separate window.

In Call Center Elite Multichannel Desktop, you receive multimedia work items, such as email, SMS,
and Chat messages blended with inbound telephone calls. All these work items are stored in
different queues based on the type of work item and priority. From these queues, the work items are
distributed to an agent with relevant skills and knowledge.

Call Center Elite Multichannel Desktop offers a complete range of telephony functions. Using these
functions, you can:

• Make a call.
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• Receive a call.
• End a call.
• Hold/Unhold a call.
• Divert a call.
• Send the Dual Tone Multi Frequency (DTMF) tones.
• Transfer a call.
• Conference a call.
• Drop contacts from a conference call.
• Forward all incoming calls to voice mail or another extension.

Call Center Elite Multichannel Desktop distributes internally held customer records to you and
prompts you to initiate contact with customers by phone.

Plug-ins
Call Center Elite Multichannel Desktop is based on the integration of different plug-ins. Based on the
settings made during the configuration, the plug-ins are loaded when the application starts. The
plug-ins interact with each other to provide a wide range of voice and multimedia functionality to
agents.

You can configure Call Center Elite Multichannel Desktop through a local .ini file or through a
Configuration server. For more information, see Administering Avaya Aura® Call Center Elite
Multichannel Guide.

Desktop Utility
The desktop plug-in is based on the configurations in the programs configured for the specific media
store. The desktop plug-in acts on the phantom call action and the agent state after the interaction
closes.

The desktop plug-in is specific to the multimedia contacts that are distributed through Avaya
Communication Manager using phantom calls.

History
The history plug-in displays the history of agents and customers. The agent history includes
information about:

• Old work items that you have handled.
• Work items that you are currently handling.
• Your conversations with a customer.

The customer history includes information about the conversation and interaction details of a
customer with whom you are currently interacting.

You can view the history of a customer without an active work item by searching the customer in the
Directory plug-in. If the customer is not present in the Directory plug-in, you can view the history by

Overview
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entering the email ID or exact phone number of the customer in the Customer ID field of Customer
History search panel.

Spell Check
The Spell Check plug-in checks the spelling in a work item.

AutoText
This plug-in provides AutoText and Work Codes buttons on the toolbar. The AutoText plug-in:

• Inserts predefined text in your current work item to save your typing time.
• Assigns a work code to a work item.

Directory
The Directory plug-in displays the contact information stored in a contact database. You can search
a database for a contact based on first name, last name, full name, or phone number.

If a contact is available, you can dial the searched contact or transfer an active call to the searched
contact, or add the searched contact in an active conference.

You can view the history of a customer without an active work item by searching the customer in the
Directory plug-in.

Printing
The Printing plug-in prints the information from a work item, session notes, and work item notes.

Print button is provided on the toolbar to use this plug-in.

Note:
In the Desktop interface with Ribbons, the Print option is only available in the File menu

IDS View Client
The IDS View Client plug-in helps to connect to the IDS server with or without Multicast IP. The
connection to the IDS server is required for the Wallboard, Presence, Dashboard, and Real-time
reporting.

Call Recording
The Call Recording plug-in records call with a customer and replays the recorded calls. In Call
Center Elite Multichannel Desktop, the recording functionality is provided by integrating the Avaya
Contact Recorder (ACR) application. For more information about ACR, see documentation on the
Avaya Support website: http://support.avaya.com/.

You can use the recording buttons on the Voice toolbar to start and stop recording a call. For more
information, see Voice toolbar on page 96.

Recorded calls are stored on the ACR server, based on the date, agent name, customer, record
length, and Vector Directory Number (VDN). In Call Center Elite Multichannel Desktop, you can
search the recorded calls based on the date, agent name, customer, and VDN.

You can also schedule a call recording, enter comments to a call recording, and give score to a call
recording.

Supervisor can also record and replay the calls that agents in their group are handling.

Plug-ins
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Rules
Using the Rules plug-in, a user can create rules that automatically perform actions on the call events
to meet certain criteria. For example, a user can create a rule to divert calls from a specific phone
number to voice mail.

Work Item Creation
The Work-Item Creation plug-in helps the agents to create new outbound work items for Email and
Preview Contact.

Work Item Notes
The Work Item Notes plug-in displays work item related notes that you create while interacting with
a customer. The Work Item Notes window displays notes only for a work item that is currently open.

You can create more than one note for a single work item and categorize these notes in the
Interaction, Conversation, and Parents groups.

Work Item Alert
The Work Item Alert plug-in alerts you when a new work item arrives. The system displays an alert
window that contains the contact details.

Wallboard
The Wallboard plug-in displays real-time and statistical information of logged in agents, VDNs,
queues, and skills.

Python Breakout
The Python Breakout plug-in helps in the development of applications in Call Center Elite
Multichannel that can invoke IronPython scripts when a specific event occurred in the Desktop
application.

Time in AUX
The Time in AUX plug-in adds a counter to the status bar of the Desktop application. The counter
indicates how much time you spent on any of the following working modes:

• Auxiliary
• Available
• After Call Work

Microsoft Dynamics CRM
The Microsoft Dynamics CRM plug-in helps you to:

• View, edit, and use Microsoft Dynamics CRM in Call Center Elite Multichannel Desktop.
• Dial from any Microsoft Dynamics CRM Web page that displays one or more phone numbers.
• Receive Microsoft Dynamics CRM activities as part of your daily tasks.
• Search and dial any Microsoft Dynamics CRM account or contact from the Call Center Elite

Multichannel directory.

An administrator creates rules that automatically perform actions on Microsoft Dynamics CRM call
events.

Overview
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Contact Management
The Contact Management plug-in displays and manages the contact information in the directory.
You can add, change, and delete contact information in a directory.

An administrator can customize the field names used for displaying contact details.

External Application Container
The External Application Container plug-in opens an external application, such as Microsoft Internet
Explorer (IE) in Call Center Elite Multichannel Desktop.

External Application Execute
The External Application Execute plug-in starts an external application, such as Notepad, in Call
Center Elite Multichannel Desktop and transfer the information from the incoming work item to this
external application. The information from a work item is stored in an XML file, which the external
application uses to display the information.

The external application is opened independently of the Desktop application.

Save Close Document
The Save Close Document plug-in saves new and edited data to the ASContact database. The
ASContact database acts as a contact directory in Call Center Elite Multichannel Desktop.

Custom Buttons
The Custom Buttons plug-in creates custom buttons that you can use to perform various call related
actions.

This plug-in works in conjunction with the Rules Plug-in. In the Rules window, you can associate a
rule to a custom button. When you click a custom button, the rule associated with that button is
executed.

Quick Dial
The Quick Dial plug-in creates quick dial buttons that you can use to quickly dial the phone number
of a customer. Quick dial buttons save your time to enter a phone number or search a contact in a
directory.

The system displays quick dial buttons on the application toolbar at a specified location.

Enhanced Dial
The Enhanced Dial plug-in enhances the dialing for you by adding your information in the dial, in a
customized format. The enhanced information is displayed in every new outbound call, transfer call,
or a conference call that you make.

Customized Forms
The Customized Forms plug-in adds one or more work forms to multimedia work items. These forms
appear on the additional tab next to a work item tab.

An administrator creates these forms in Call Center Elite Multichannel Control Panel.

Close Suspend Work Item
The Close Suspend Work Item plug-in suspends a work item so that the work item can be presented
to another agent at a later date. While suspending the work item, you can specify the preferred

Plug-ins
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agent to whom the work item must be presented. You can also close the work item and record its
outcome.

Preview Contact
The Preview Contact plug-in contacts a customer using an outbound call, email, or Short Message
Service (SMS) for a campaigning purpose.

The Preview Contact media store generates work items from a database. These work items are
delivered to you to initiate an outbound contact.

Simple Messaging
The Simple Messaging plug-in receives simple messaging work items.

Chat Welcome Message
The Chat Welcome Message plug-in sets a chat welcome message. The system displays the chat
welcome message to a customer when you accept the chat work item from the customer.

Email
The Email plug-in receives email work items.

Email Template
The Email Template plug-in creates an outbound email using the default email templates. The text
and attachments in an email template are automatically added in an outbound email that you are
replying or forwarding to a customer.

Telephony
The Telephony plug-in connects to Avaya Aura® Communication Manager.

Presence
The Presence plug-in monitors the telephone activity of other agents in a contact center.

Using the Presence plug-in, you can also view the work item history of any agent.

Session Notes
The Session Notes plug-in records notes for your day-to-day activities. These notes are not
specifically related to a work-item.

Voice
The Voice plug-in helps you to make, answer, hold, unhold, transfer, conference, and end calls. You
can also send the DTMF tones to a customer who is using Interactive Voice Response (IVR)
system. For more information, see Sending DTMF tones on page 62.

The Voice toolbar is available on the Desktop interface to perform voice functions.

User
The User plug-in helps you to log in and log out of skills, use advance logging functionality, change
work mode, select reason codes, access voice mail, and forward calls to another agent.

The User toolbar is available on the Desktop interface to perform user actions.
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Supervisor
The Supervisor plug-in helps supervisors to monitor the call activity of an agent or group of agents.
As a supervisor, you can:

• View or change the current state of an agent.
• Join a call as an observer in which you can hear the conversation without an agent and

customer knowing that you have joined the call.
• Join a call as a coach in which you and an agent can communicate with each other without the

customer knowing that the agent is interacting with you.
• Join a call as a participant in which an agent, a customer, and you can communicate with each

other.
• Log out an agent.

Using the Supervisor plug-in, you can also view the work item history of any agent.

Media Client
With the Media Client plug-in, an agent can:

• Log on to a station using the Station Login button on the Call Center Elite Multichannel
Desktop.

• Mute and unmute a voice call using the Mute Audio and Unmute Audio buttons on the Call
Center Elite Multichannel Desktop.

• Select specific input and output devices.

In addition, the built-in Media Client feature provides the following functionalities:

• Works with a separate license.
• Provides a built-in soft phone in H.323 mode.

Note:
By default, this plug-in is disabled. For information about how to enable this plug-in, see
Administering Avaya Aura® Call Center Elite Multichannel.

Multimedia suite
Call Center Elite Multichannel Desktop interacts with Media Director, Media Proxy, and the following
media stores and media gateways for multimedia functionality:

• Email Media Store

• Preview Contact Media Store

• Simple Messaging Media Store

• Web Chat Gateway

• Short Message Service (SMS) Gateway

• Google Hangouts Gateway

Multimedia suite
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For more information about how work items are generated and delivered to agents, see
Administering Avaya Aura® Call Center Elite Multichannel Guide.

Call Center Elite Multichannel licensing
An administrator must buy licenses according to the requirements to set up the contact center using
Call Center Elite Multichannel.

Avaya provides separate licenses for all the supported features. An administrator must buy a license
key with a sufficient number of run-time licenses for each agent who will use the Desktop
application.

The following table lists the Call Center Elite Multichannel features and the corresponding licenses:

Feature License name
Voice VALUE_CCEM_VOICE
Multimedia VALUE_CCEM_MULTIMEDIA
Microsoft Dynamics CRM VALUE_CCEM_MSCRM

Note:

This license key covers unlimited run-time licenses.
Media Client VALUE_CCEM_MEDIACLIENT

Call Center Elite Multichannel license requirements
In Call Center Elite Multichannel, License Director is a central repository for all Call Center Elite
Multichannel licenses. License Director polls the required licenses from the WebLM server that an
administrator configures in Call Center Elite Multichannel Control Panel.

For more information about how to add a license key to License Director, see Administering Avaya
Aura® Call Center Elite Multichannel Guide.

Error logging
Call Center Elite Multichannel Desktop logs error information relating to its operation in different log
files on a local system or on the TTrace server. The application stores the log information using the
Avaya Common Logging format.

On a local system, Call Center Elite Multichannel Desktop creates a new log file every day. The
name of the error log file clearly identifies the application and the day of the week, for example,
MonASGUIHost.log.

Overview
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After the log file size reaches the limit specified in the configuration, the system archives the log file
and creates a new log file.

Note:

The system stores only one log file in an archive. If a second error log file reaches the specified
maximum size, the system overwrites the previously archived log file.

Error logging requirements
For logging on the TTrace server, you must provide TTrace parameters, such as TTrace server and
TTrace server port in the Desktop configuration file and set the Error Log Mode parameter to 2. By
default, the Error Log Mode parameter is set to 1, which instructs Call Center Elite Multichannel
Desktop to create logs on a local system.

For more information about the TTrace logging, see Administering Avaya Aura® Call Center Elite
Multichannel Guide.

Error logging levels
The types of errors that the system logs in a local error log file or on the TTrace server are
determined by the logging level defined in the Desktop configuration file or in the Trace system.

The following table lists the error logging levels:

Error logging level Description
0 No error logging takes place.
1 Logs fatal, major, minor, and trace information.
2 Logs fatal, major, and minor errors.
4 Logs fatal and major errors.
8 Logs only fatal errors.

Each file records the selected logging level as well as the date, time, location, and description of
every error that occurs.

The system saves each error log file in the current working folder of Call Center Elite Multichannel
Desktop, which is the same folder where the application executable is available.

Diagnostic testing error logging
You can use a custom log level to create log files that do not overwrite each other, every time the
maximum file size limit is reached. To set the logging level, see Setting the diagnostic error logging
level on page 20.

Error logging
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Caution:

To prevent creating multiple log files that consume your available disk space, you must use this
error log level only when you perform diagnostic testing.

Setting the diagnostic error logging level
Procedure
Set the error logging level by adding 128 to one of the default logging levels.

For example, in the configuration file, if you specify Error Log Level=129, the new error log files
are created that contains error information, related to fatal, major, minor, and trace errors.

Each new log file name is unique and is based on the date, year, month, and day format, with time
in hours, minutes, and seconds format. For example, YYYYMMDDHHMMSSASMediaDirector.log,
where,

YYYY = Year MM = Month DD = Day
HH = Hour MM = Minute SS = Second

For information on error logging levels, see Error logging levels on page 19.
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Chapter 3: Desktop interface

The following are the two options for viewing the Call Center Elite Multichannel Desktop interface:

• Desktop interface with Ribbons

• Desktop interface with Menus

Desktop interface with Ribbons
This interface contains UI controls, such as ribbon tabs, panels, and status bars. You can use the UI
controls to manage various types of work items.

The following is the Call Center Elite Multichannel Desktop interface with Ribbons.

This interface consists of a File menu and the following Ribbon tabs:

• Home

• Voice

• Email

• Chat

• PCMS

• DMCC

• Custom
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Button groups

Button
group

Button
name

Icon Description Present
in
Ribbon
tab

Call
Control

Answer Answers an active work item. All

Hold Puts an active voice call on hold.

You must use the Hold option when you want to
transfer the call, conference the call, or discuss a
customer query with your supervisor.

Drop &
Release

Drops the current voice call.

User AUX You can change your work mode to Auxiliary
(AUX). The AUX mode indicates that you have
taken a break, for example, lunch break.

All

ACW You can change your work mode to After Call
Work (ACW). The ACW mode indicates that you
are doing an after call work, such as updating
notes or filling forms.

Available You can change your work status to Available to
receive work items.

Spell
Check

Post Spell
Check

A single button to check the spelling in a work
item, work item notes, and session notes.

The Spell Check feature is powered by Keyoti
RapidShell .Net Spell Checker, Keyoti Inc. For
more information, go to http://www.keyoti.com.

All

Auto Spell
Check

A setting that forces Call Center Elite Multichannel
Desktop to automatically check the spelling of
words as you type the text inside the selected
window.

Work
Item

AutoText Displays the autotext entries that an administrator
has configured in Control Panel.

All

Table continues…

Desktop interface
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Button
group

Button
name

Icon Description Present
in
Ribbon
tab

Work Code Displays the work codes that an administrator has
configured in Control Panel.

Close Closes the work item and records the outcome of
the work item.

Utilities Calculator Displays the inbuilt calculator for mathematical
calculations.

Home

World
Clock

Displays two clocks where one clock shows the
current time on the system of the agent and the
other clock shows the time configured according to
the requirement of the agent.

Agent Login/
Logout

Logs in or logs off the agent to the Desktop
application.

Home

User
Settings

Call
Forward is
not active/
Call
Forward to
<number>

Forwards an active voice work item to a number
that you specify in the Forward to field.

Home

Voicemail Displays the voice mail messages that you
received.

Send All
Call

Forwards all voice work items to a predefined
destination.

Station Login/
Logout

Registers or unregisters an Agent Station on
Communication Manager. Call Center Elite
Multichannel Desktop displays this button only
when the Media Client plug-in is enabled.

Home

Audio Mute/
Unmute

Mutes or unmutes a call. Voice

Call
Outboun
d

Dial Field Displays the phone number of a contact.

When you click the Dial pad, the system dials the
phone number displayed in this field.

Voice

Table continues…

Desktop interface with Ribbons
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Button
group

Button
name

Icon Description Present
in
Ribbon
tab

Dial When you click the Dial pad, the system dials the
phone number displayed in the Dial field.

Send
DTMF
Tones

Sends Dual Tone Multi Frequency (DTMF) tones
required for an Interactive Voice Response (IVR)
system, such as telebanking and voice mail
prompts.

Transfer Transfer Transfers an active voice call to another number.
For example, another agent or a supervisor.

The following are the available options for transfer:

• Blind Transfer

• Consult Transfer

• Complete Transfer

• Abort Transfer

Voice

Conferenc
e

Adds a contact to an active conference.

The following are the available options for
conference:

• Blind Conference

• Consult Conference

• Complete Conference

• Abort conference
Call
Recordin
g

Start
Record

Starts recording a voice call. Voice

Stop
Record

Stops recording a voice call.

Replay
Recording
s

Opens the webpage of the Avaya Contact
Recorder application. After logging in to the Avaya
Contact Recorder application, you can search and
replay the recorded calls.

Quick
Dial

<A user-
specified
name>

Quickly dials the phone number of the customer
for which the quick dial button is configured.

Voice

Table continues…
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Button
group

Button
name

Icon Description Present
in
Ribbon
tab

New New Email Creates new outbound work items and child work
items for Email.

Email

Suspend Suspend
WorkItem

Suspends a work item for Email to present it to
another agent at a later date.

Email
and
PCMS

Reply
and
Forward

Reply Opens a new tab for you to reply to an email that
you receive from a customer.

In the new email tab:

• The Subject field displays the subject from an
email that you received.

• The To field displays the email address of a
customer from whom you received the email.

• The email body displays two sections, separated
with a separator. You can drag this separator to
resize the sections.

The lower section displays the original email.
You can enter your response to the customer
query in the upper section.

The arrow button (  / ) on the right side of
the From field shows and hides a part of the
information from the upper section. The purpose
of hiding the information from the upper section
is to provide larger area for the original email.

Note:

The button is enabled only when you have an
active email work item.

Email

Reply All Opens a new tab for you to reply to the email that
you receive from a customer. The email is sent to
all the email addresses mentioned in the original
email.

The functionality of this option is same as the
Reply to Email option. The To, Cc, and Bcc fields
show the same email address from the original
email.

Table continues…

Desktop interface with Ribbons
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Button
group

Button
name

Icon Description Present
in
Ribbon
tab

Forward Opens a new tab for you to forward this email to
another person. For example, supervisor or
another contact.

You can enter the email addresses in the blank
To, Cc, Bcc fields to forward this email.

Forward
To RE

Opens a new tab for you to send an email to a
Resident Expert.

You must send an email to a Resident Expert
when you are unable to understand a customer
query or when advance skills are required to
resolve a customer query.

In the new email tab:

• The To field changes to a drop-down list. You
can select the email address of a Resident
Expert from the drop-down list.

• The Cc, Bcc, and Subject fields are disabled for
editing.

• You can select the Reply directly to customer
check box, so that the Resident Expert can send
the email to the customer.

Actions Send As
Default

Sends a new active email or an active email that
you are replying to or forwarding to a customer or
a Resident Expert.

After you send an email from the Desktop
application, the tab of the original email work item
becomes active.

This button is enabled only when the tab of an
email that you are sending, replying, or forwarding
is active.

When you click the upper part of this button, the
system determines the outgoing email format
based on the queue setting in EMS.

When you click the arrow on the lower part of this
button, you see the following options:

• Send as Plain Text

• Send as HTML

Email

Table continues…

Desktop interface
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Button
group

Button
name

Icon Description Present
in
Ribbon
tab

When you perform one of the following steps, all
outbound emails are sent in HTML format
irrespective of the format of inbound emails:

• In the ASEmailMediaStore.ini file, set the
Send Email As HTML Format parameter to True.

• In Call Center Elite Multichannel Control Panel,
edit an EMS queue and select the Send Email
As HTML Format check box.

However, an outbound email is sent in Plain Text
when you explicitly select the option to send the
email in Plain Text.

Attach
File(s)

Opens the file Open dialog box to select a file that
you want to attach to an email.

The Attachment field displays all the files that you
have attached.

To remove an attached file, you can select a file
and press Delete. You can also right-click a file
and select Remove attachments.

Save Email Saves an email. Email

New New PCMS Creates new outbound work items and child work
items for Preview Contact.

PCMS

DMCC
Buttons

EC500 Administers the Extension to Cellular button on a
deskphone. When you enter a value, the system
displays the Timer subfield where n is the default
value. If you leave the default value unchanged,
the system excludes the timer state.

To include an Extension to Cellular timer state for
the administered feature button, set the Timer
subfield to y.

After you include the timer state, the Extension to
Cellular user can activate a one-hour timer to
temporarily disable the feature.

DMCC

MCT
Activate

Sends a message to the Malicious Call Trace
(MCT) control extensions so that the user can

Table continues…

Desktop interface with Ribbons
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Button
group

Button
name

Icon Description Present
in
Ribbon
tab

trace a malicious call. MCT activation also starts
recording the call if your system has an MCT voice
recorder.

MCT
Control

Provides control of a malicious call trace request.
When the user presses the MCT Control button,
the system displays the called party information.
Pressing the button again displays the rest of the
trace information. The MCT controller must dial the
MCT Deactivate feature access code to release
control.

After the user becomes the MCT controller, the
system stops notifying any other MCT Control
extensions of the MCT request.

SAC Temporarily directs all incoming calls to coverage,
regardless of the assigned call-coverage
redirection criteria.

Call FWD Activates forwarding of multimedia calls as
multimedia calls, not as voice calls.

Auto Dial Sets the specified Dial Number as a favorite.
Stroke
count

Sends a message to CMS to increment a stroke
count number.

Work
codes
Account Opens a screen where the user can enter Call

Detail Recording (CDR) account codes. With the
CDR account codes, the system can associate
and track calls according to a particular project or
account number.

Vu-Stats Opens a screen where the user can specify a
display format for the statistics. If you assign a
different VuStats display format to each button, the
agent can use the buttons to access different
statistics.

You can assign this button only to telephones that
have a display. You must specify the following:

• Format: The number of the format that you want
the button to display.

• ID (optional): A split number, trunk group
number, agent extension, or VDN extension.

Table continues…
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Button
group

Button
name

Icon Description Present
in
Ribbon
tab

Headset Signals onhook or offhook state changes to
Communication Manager. The green LED is on for
offhook state and off (dark) for onhook state.

Supervisor
Assist

Places a call to a split supervisor. This button is
used by an ACD agent.

Busy
indicator

Adds or removes the busy indicator.

uui-info Opens a screen where the user can see up to 32
bytes of ASAI-related UUI-IE data.

VOA Enables or disables VDN of Origin Announcement
(VOA). VOA must be enabled.

Mute far-
end

Puts a selected party on a conference call on
mute. This button can be assigned to stations and
attendant consoles.

Hunt NS Places a Hunt Group into night service.

Q-Calls Enables flashing of the associated status lamp
after a call warning threshold is reached.

Q-time Enables flashing of the associated status lamp
after a time warning threshold is reached.

Bridged
appearanc
e

Provides an appearance of another user extension
on this telephone.

For example, an assistant might have a bridged
appearance of the supervisor extension. The
bridged appearance button functions exactly like
the original call appearance, for instance, it
indicates when the appearance is active or ringing.
You can assign Bridged appearance buttons only
to 2-lamp appearance buttons. You must indicate
the extension and call appearance button that the
user wants to monitor at this telephone.

Custom
Buttons

<A user-
specified
name>

Performs various call related actions.

You can associate a rule to a custom button.
When you click a custom button, the rule
associated with that button is executed.

Custom

Note:
In this interface, tool tips for split buttons are displayed under the Ribbon toolbar.
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Desktop interface with Menus
This interface contains UI controls, such as menus, toolbars, panels, and status bars. You can use
the UI controls to manage various types of work items.

The following is the Call Center Elite Multichannel Desktop interface with Menus.

Toolbars
The Desktop interface contains the following toolbars:

AutoText
A single button to insert pre-defined text into a current work item, which saves your typing time. The
text is categorized by topics and presented through a drop-down list. Email or chat program has an
associated list of AutoText. Therefore, for every work item that you process, you can view the
relevant AutoText options. For more information, see AutoText and Work Code toolbar on
page 97.

Work Codes
A single button to assign a work code to a work item. The work codes are categorized by topics and
presented through a drop-down list. Each Media Store queue has an associated list of work codes.
Therefore, for every work item that you process, you get the relevant Work Code options. For more
information, see AutoText and Work Code toolbar on page 97.

Spell Check
A single button to check the spelling in a work item, work item notes, and session notes.
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The Spell Check feature is powered by Keyoti RapidShell .Net Spell Checker, Keyoti Inc. For more
information, go to http://www.keyoti.com.

Spell Check As You Type
A setting that forces Call Center Elite Multichannel Desktop to automatically check the spelling of
words as you type the text inside the selected window.

User
A set of buttons to log in and log out of skills, to change the work mode, to select the reason codes,
to gain access to voice mail, and to forward calls to another agent. For more information, see User
toolbar on page 93.

Voice
A set of buttons to answer, to transfer, to conference, and to end calls. For more information, see 
Voice toolbar on page 96.

Email
A set of buttons to perform all email functions. For more information, see Email toolbar on
page 94.

Printing
A single button to print the information associated with a work item.

Media Client
Setup buttons to log in or log off the Agent Station on Communication Manager. For more
information, see Media Client toolbar on page 97.

Windows
The Desktop interface contains the following windows:

Document
Windows to view and manage multimedia work items. The windows also display an external
application, such as Microsoft Internet Explorer. The windows appear in the form of tabs.

You cannot drag a Document window to another location.

Tool
Windows that display information related to logged in agents, multimedia work items, notes, and
templates. You can drag the windows, dock the windows in any position, or hide the windows. You
can display the hidden window by holding a mouse pointer over the corresponding window tab.

The following tool windows are available in Call Center Elite Multichannel Desktop:

Work Item Notes: 
A window in which you can view and record the notes related to the work items. You can record
multiple notes for a single work item. The notes are arranged chronologically. You must click the
note title to view the contacts.

Session Notes: 
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A window in which you can view and record notes that help you to perform your day-to-day
activities. The notes do not specifically relate to a work-item.

The Session Notes window helps you to write notes directly in Call Center Elite Multichannel
Desktop instead of opening an external application, such as Notepad. The system automatically
stores the session notes in the Rich Text Format (RTF) format, as you type the text. The system
loads the session notes every time you start the application.

Presence: 
A window in which you can monitor the phone activity of other agents in a contact center with whom
you regularly interact. At a glance, you can view if an agent is on a call, logged in to receive work
items, or in the Auxiliary, Available or the After Call Work mode.

Note:
In the Presence window, when you select an agent and click Show history, the system
populates the agent history in the History window.

History: 
This window displays Customer History and Agents History tabs. On the Customer History tab, you
can view a conversation and interaction history of customers. On the Agents History tab, you can
view a list of work items that you or another agent, that you specify, has previously worked on. You
can also search work items, based on the agentID, state, and the work item type, such as email,
preview contact, or simple messaging.

Directory: 
A window in which you can search a contact based on the first name, last name, full name, phone
number, contact ID, or the Instant Message (IM) address.

After the Directory window displays the searched contact, you can initiate a call with the contact or
send an email, SMS to the contact directly from the Directory window. You can also transfer an
active call to the searched contact or add the searched contact in an active conference.

Note:
In the Directory window, when you select a customer and click Show history, the system
populates the customer history in the History window. If the History and Directory windows are
docked together, you must manually click the History tab to view the customer history.

Wallboard: 
A window in which you can view real-time statistical information of agents. You can also view Vector
Directory Numbers (VDNs), queues, splits/skills and alerts. If you resize the window, the system
automatically resizes the text displayed in this window.

Resizing a window
Procedure

1. Move the mouse pointer over the edge of a window.

2. When the mouse pointer changes to a double-headed arrow, drag and drop the line to a new
position.

The system automatically updates the new position and size in the configuration of Call
Center Elite Multichannel Desktop.
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Docking a tool window
About this task
In the Desktop interface, you can move and dock a window based on your preference. When you
drag a window, the application displays dock guides. These dock guides help you to decide a
location to dock a window.

Procedure
Drag and drop the window to one of the dock guides.

Note:

If a window that you want to dock is not docking, you must right-click the title bar of the window
and select Dockable.

The window is automatically docked to a position according to the dock guide you select.

Inner guides field descriptions

The following table describes the name and description of the inner guides.
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Name Description
Left Inner Docks a window to the left of the document window, the working area of the

Desktop window. The window height is restricted if there are adjacent windows.
Top Inner Docks a window above the document window. The window width is restricted if

there are adjacent windows.
Right Inner Docks a window to the right of the document window. The window height is

restricted if there are adjacent windows.
Bottom Inner Docks a window below the document window. The window width is restricted if

there are adjacent windows.

Outer guides field descriptions
The following table describes the name and description of the outer guides.

Name Description
Left Outer Docks a window that spreads across the left side of the screen.
Top Outer Docks a window that spreads across the top side of the screen.
Right Outer Docks a window that spreads across the right side of the screen.
Bottom Outer Docks a window that spreads across the bottom of the screen.

Hiding a tool window
About this task
If your screen becomes cluttered with many open or docked windows, you can temporarily hide
some of the Tool windows.

Procedure
1. Click the down arrow at the right side of the title bar of a window.

2. Select Auto-Hide.

The window collapses from its docked state to an auto-hide tab, which appears at the edge
screen.

Note:

In the Desktop interface with Ribbons, when you auto-hide grouped Tool windows, some
of the auto-hide tabs for the grouped Tool windows display as collapsed.

Viewing a hidden tool window
Procedure
Hold the mouse pointer over the auto-hide tab of a window or click the auto-hide tab of the required
window.

The window opens with a size and location stored earlier.
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Note:

By default, a hidden tool window is configured to be displayed on clicking the auto-hide tab.
However, you can configure a hidden tool window to be displayed on holding the mouse pointer
over the auto-hide tab.

Displaying a tool window as a tabbed document
Procedure

1. Click the down arrow at the right side of the title bar of a window.

2. Select Tabbed Document.

The window collapses from the docked state to a tabbed state.

Navigating around the screen
Procedure

1. Perform one of the following actions:

• Hold Control and keep pressing Tab.

• Hold Control and the up and down arrow keys.

The system displays a dialog box with the names of active windows.

2. On the dialog box, click the required window name and release Control.

The selected window becomes active and appears with an orange color title bar. All the
other inactive windows appear with the blue color title bar.

Logging in to skills
Procedure

1. Perform one of the following actions:

• Click the Agent Login arrow on the toolbar.

• Click User > Agent Login > Agent Login on the menu bar.

Note:

• If the advanced login feature is enabled in your configuration, click Agent Login to
change the agent login details.

• When you log in for the first time, Call Center Elite Multichannel Desktop places you in
a mode specified during the configuration.
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Important:

• If Agent authentication is enabled on the Call Center Elite Multichannel server and an
agent attempts to log in to the Call Center Elite Multichannel Desktop using incorrect
user ID or password, the system displays the following message:
Authentication Failure.
Please try again using correct Agent ID and Password.
After the agent makes the permissible number of failed login attempts, the system
locks the Agent ID and displays the following message:
Agent ID xxxxx is locked because of multiple failed login 
attempts.
Please contact the appropriate authority to unlock the Agent 
ID.
You can configure the permissible number of failed login attempts and the time
interval to unlock the agent in the Agent Authentication section of the
AXMLServer.ini file. For more information, see Administering Avaya Aura® Call
Center Elite Multichannel.

• If Concurrent Agent login is disabled on the Call Center Elite Multichannel server and
a Desktop is monitoring a station, the system displays the following message when
another Desktop attempts to monitor the same station:
Station ID xxxxx is already in use by another Desktop.
Please specify a different Station ID in the configuration.
If an agent is logged in to a Desktop using an Agent ID and another agent attempts to
log in using the same Agent ID, the system displays the following message:
Agent ID xxxxx is already in use by another Desktop.
Please specify a different Agent ID in the configuration.

2. Perform one of the following actions, if you are not in the Available mode:

a. Click Available on the toolbar.

b. Click User > Available on the menu bar.

Note:

When you end the call, you are placed either in the Available or the After Call
Work mode, depending on the system configuration. Click Available to receive
calls.

3. Perform one of the following actions, if you want to become unavailable to receive calls so
that you can perform a call-related activity, such as filling a form:

a. Click After Call Work on the toolbar.

b. Click User > After Call Work on the menu bar.

This places you in the After Call Work mode.
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4. To perform an activity that is not related to the call, such as going to lunch, do one of the
following actions:

• Click Auxiliary on the toolbar.

• Click User > Auxiliary > Auxiliary on the menu bar.

This places you in the Auxiliary mode.

If reason codes are enabled, select a reason for changing your work mode to Auxiliary by
clicking the Auxiliary arrow on the toolbar.

Logging out of skills
Procedure
Perform one of the following actions:

• Click Agent Logout on the toolbar.

• Click User > Agent Logout > Agent Logout on the menu bar.

If reason codes are enabled, select a reason for logging out by clicking the Agent Logout arrow on
the toolbar.

Handle multiple work items
Using the Multiple Call Handling feature, the staffed agents can take additional work items without
closing their currently active work items. Call Center Elite Multichannel supports the following modes
of Call Center Elite:

• Multiple Call Handling - On Request

• Multiple Call Handling - One Forced

• Multiple Call Handling - One Per Skill

• Multiple Call Handling - Many Forced

For information about these modes, see Avaya Aura® Call Center Elite Feature Reference.

Call Center Elite Multichannel supports the Multiple Call Handling - On Request mode only if you set
the On Request MCH Enabled configuration parameter to True. For information about this
parameter, see Installing Call Center Elite Multichannel.

If you enable the Multiple Call Handling - On Request mode, the Available button on the Call Center
Elite Multichannel Desktop is enabled when the agent puts the current work item on hold.

Note:

• Avaya Communication Manager reserves one line appearance to transfer or forward calls.
Therefore, Call Center Elite Multichannel Desktop or Call Center Elite Multichannel
Reporting allows making the agent available until N-1 work items are established. In this
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case, N specifies the number of line appearances. After N-1 work items are established,
the Available button remains enabled but does not allow the agent to be available for
receiving any work item.

• Any mode of Multiple Call Handling (MCH) must be used only with Phantom call drop
disabled.

Creating a vertical or horizontal group of work items
About this task
You can create groups of work item tabs and arrange the groups horizontally or vertically. You can
also move a work item tab from one group to another.

Arranging work item tabs help you to simultaneously view information of all work items.

Procedure
Perform one of the following actions:

• Right-click the work item tab for which you want to create a new group and select New Vertical
Tab Group.

• Right-click the work item tab for which you want to create a new group and select New
Horizontal Tab Group to arrange that group horizontally.

Important:

The New Vertical Tab Group and New Horizontal Tab Group options are visible only when
more than one work item tab is open.

The system creates a new vertical or horizontal group and displays the selected work item tab in the
new group. The new group is arranged vertically or horizontally with other groups.

Note:

The system automatically adds the new incoming work item to a new group. You can repeat the
steps to create new groups for new work items.

Moving a work item to another group
Procedure

1. Right-click the work-item tab and select Move to Next Tab Group or Move to Previous Tab
Group.

The system moves the selected work item to another group.

2. Repeat this step until the work item is moved to the required group.
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Note:

Click the down arrow to display a list of the work items in a particular group.

Click the left or right arrow to move between several work items in a group.

Accepting a work item
Procedure

1. Start and log in to Call Center Elite Multichannel Desktop.

2. Change your work status to Available to receive work items.

3. When you receive a work item, click the text on the alert message that appears on your
desktop.

• If the customer contact in a work item matches with a record in the ASContact Database,
the system displays a vertical contact tab as part of the work item. While handling this
work item, you can click this contact tab and edit contact details of the customer. For more
information, see Editing the contact details on page 50.

• If the customer contact in a work item does not match with a record in the ASContact
database, you can create a new customer contact record and associate it with this work
item. For more information, see Adding a new contact to a directory on page 49. Next
time, when the same customer contacts again, the system automatically displays contact
records as part of the work item.

• If the Microsoft Dynamics CRM Gui plug-in is enabled, Call Center Elite Multichannel
Desktop tries to match the details of the incoming work item to one of the Microsoft
Dynamics CRM account or contact records.

If Call Center Elite Multichannel Desktop cannot find a match, the Microsoft Dynamics CRM
Gui plug-in works based on its default configuration settings. In this case, the plug-in does
nothing or opens a blank contact or account record as the vertical tab on the work item in
which you can fill the details.

If Call Center Elite Multichannel Desktop finds a match, you can view and edit the contact
details.

Inserting an autotext entry
Procedure

1. Place the cursor where you want to insert an autotext entry.

2. Click the AutoText arrow on the toolbar and select an appropriate key.
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Note:

If autotext previewing is enabled, hover your mouse over the key for few seconds to
preview the value that will be inserted into your work item.

Checking the spelling of a word
About this task
When you type text in a work item, the words that are spelled out incorrectly or unavailable in the
dictionary are marked with a red underline.

Procedure
1. Right-click the word with a red underline.

The system displays a list of correct words that you can use.

Note:

Call Center Elite Multichannel Desktop automatically uses the dictionary specified for the
Dictionary File Name parameter in the configuration.

2. Click the correct word.

Checking the spelling in a work item
Procedure

1. Perform one of the following actions:

• Click Spell check on the toolbar.

• From the Edit menu on the menu bar, select Spell Check.

The system displays the Spelling dialog box. In the dialog box, you can view a list of
suggested words.

2. Perform one of the following actions:

• Select the most appropriate word from the suggested words, and click Change to change
the word.

• Click Ignore to ignore the suggested change and continue the spelling check.

• Click Add to add the word that you are checking to the dictionary.

3. Click OK when you complete the spelling check.
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Recording notes for a work item
Procedure

1. Open the Work Item Notes tool window.

2. In the upper section, right-click the appropriate category for recording notes and select Add
new notes.

The following categories are available:

• Interaction

• Conversation

• Parents

The system adds a note title containing agent ID, current date, and time to the selected
category.

3. Select the note title and enter the work item related notes in the lower section.

If your work item has a history of earlier notes, the system displays these notes when you
select the work item.

By default, notes are presented in chronological order, with the oldest note at the top and the
newest at the bottom.

Editing an existing note
About this task

Note:
You can only edit notes that you have created.

Procedure
1. Open the Work Item Notes tool window.

The system displays a list of notes that you have created.

2. In the upper section of the window, select a note title that you want to edit.

3. In the lower section of the window, edit the text.

The system saves the edited text as you typed.
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Suspending a work item
About this task
When you suspend a work item, the system sends the suspended work item to Media Director.
Media Director then sends the work item to an appropriate agent at a later date and time.

Procedure
1. Click the Suspend the work item arrow on the toolbar and select the date and time till you

want a work item to be suspended.

2. In the Reason field, enter the reason for suspending a work item.

3. In the Preferred agent field, enter the ID of a preferred agent who can handle the work item
when the item is resumed.

Note:

The Preferred Agent functionality is a best effort routing and depends on the routing
algorithm of Communication Manager.

4. Click OK.

Once you process an email either by forwarding, replying, or suspending, your work mode
changes to the Available or the After Call Work mode.

If you have logged in as an Auto-In agent, Call Center Elite Multichannel Desktop
automatically changes your work mode to Available.

If you have logged in as a Manual-In agent, change your work mode to After Call Work.

To change your work mode to Available to receive another call, click Available on the
toolbar.

Assigning a work code to a work item
Procedure

1. Click the Work Code arrow on the toolbar and select the appropriate key from the available
option.

Note:

If an administrator has enabled Work Code previewing, you can hover the mouse over
the key for few seconds to preview the value that is assigned to your work item.

2. To add or update any additional information associated with this contact, do it in the
Additional Information section of the work item.
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Closing a work item
Procedure
Click the cross icon at the upper-right side of the Document window or right-click the document and
click Close.

Printing information
Procedure

1. Perform one of the following actions:

• Click Print on the toolbar.

• From the Edit menu on the menu bar, click Print.

The system displays the Print dialog box.

2. In the dialog box, select the required printing options and click Print.

If more than one window is associated with an open work item, the system prints information
from each window and separates it by a line.

Using History
About this task
The History window displays information about an agent and a customer.

Procedure
Click the Agent History tab to view the agent history and the Customer History tab to view the
customer history.

On each tab, you can select various options to view the required information.

Opening a work item to perform an action
Procedure
Right-click a work item and select Open Interaction.

The system displays the work item as a new Document window tab. You can perform actions, such
as replying to an email work item or calling a customer from a preview contact work item, based on
the type of work item.

Note:

You cannot change the work item details.
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Viewing the history of a work item
Procedure
Right-click a work item and select Get Interaction History.

The system displays the history of a work item in the Segment history for interaction window. The
history contains the work item states. For example, created, queued, delivered, established,
retrieved, closed, and suspended.

Searching the work history of an agent
About this task
The Agent History tab in the History window displays a list of work items that you, or another agent
that you specify, handled previously.

On the Agent History tab, you can search for work items based on the agentID, state, and work item
type, such as email, preview contact, or simple messaging.

Procedure
1. In the History window, click the Agent History tab.

2. In the Agent ID field, enter the agent ID of an agent whose work items you must view.

Note:

By default, the Agent ID field displays the ID of an agent who is currently logged in to
Call Center Elite Multichannel Desktop. You can enter the agent ID only if the Allow
Search Other Agents parameter is enabled in the configuration of Call Center Elite
Multichannel Desktop.

3. From the Type drop-down list, select the type of work items you want view.

The following types are available in the list:

• Voice
• Email
• Preview Contact
• Simple Messaging

You can select All to select all types of work items.

4. In the Days old field, enter the number of days since when you want to view the work items.

5. (Optional) In the Maximum returned field, enter the number of work items that you want the
search option to display.

6. In the State list, select one or more states of work items.

The following states are available in the list:

• Suspended
• Closed
• Created
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• Processing

• Queued

• Delivered

• Established

• Pending close

You can click the Select all check box to select all states.

7. Click Search.

The system displays work items, referred as interactions, in a group according to
conversation. Each conversation has its own ID. For example, transferred Web Chat
interactions are grouped together under a common conversation ID.

Important:

Ensure that the time on the following systems is synchronized:

• Call Center Elite Multichannel Reporting or Call Center Elite Multichannel Desktop of
all agents

• Call Center Elite Multichannel core server

• Call Center Elite Multichannel database server

This synchronization is mandatory to get the correct results. To synchronize the time,
you can use an NTP server or a domain server.

Viewing a customer conversation history
About this task
The Customer History tab in the History window displays the conversation and interaction history of
a customer.

Procedure
1. In the History window, click the Customer History tab.

2. In the Customer ID field, enter one of the following inputs based on your requirement:

• The exact phone number of the customer whose details are not available in ASContact
Database.

• The email ID of the customer whose details are not available in ASContact Database.

• The GUID of the customer whose details are available in ASContact Database.

3. In the Customer field, verify the name of the customer.

4. Select the Retrieve the conversation history when a new work item is delivered check
box to display the conversation history of a customer.

The Interaction list panel displays the information about the current conversation and all the
previous conversations associated with the contact. The information contains conversation
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details, such as type, state, agent ID, From Address, To Address, Subject, and Interaction
ID.

Note:

If the system displays the customer ID for a conversation, the customer is matched with
a contact record in ASContact Database.

By default, the conversations are sorted according to the interaction ID. You can sort the
conversations by clicking the column heading of the respective column.

5. Select the Retrieve the interaction history when a new work item is delivered check box
to display the interaction history of the conversation.

The Segment history for interaction panel displays the information about your interaction
with the customer. The information contains interaction details, such as state, time, Suspend
To Time, Suspend Reason, and Preferred agent ID.

By default, the interactions are sorted according to the time. You can sort the interactions by
clicking the column heading of the respective column.

Note:

When you attempt to view a customer conversation history through the Show History
option, the Retrieve the conversation history when a new work item is delivered
and Retrieve the interaction history when a new work item is delivered fields are
ignored from the filter.

6. In the Days old field, enter the number of days since when you want to view the work items.

7. (Optional) In the Maximum returned field, enter the number of work items that you want the
search option to display.

8. From the Type drop-down list, select the type of work items you want view.

The following types are available in the list:

• Voice
• Email
• Preview Contact
• Simple Messaging

By default, the All option is selected.

9. In the State list, select the state of work items.

The following states are available in the list:

• Suspended
• Closed
• Created
• Processing
• Queued
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• Delivered

• Established

• Pending close

By default, the Select all check box is selected.

Note:

For automatic history retrieval of work item, Type and State fields are ignored.

10. Click Search.

The system displays work items, referred as interactions, in a group according to
conversation. Each conversation has its own ID. For example, transferred Web Chat
interactions are grouped together under a common conversation ID.

Important:

Ensure that the time on the following systems is synchronized:

• Call Center Elite Multichannel Reporting Desktop or Call Center Elite Multichannel
Desktop of all agents

• Call Center Elite Multichannel core server

• Call Center Elite Multichannel database server

This synchronization is mandatory to get the correct results. To synchronize the time,
you can use an NTP server or a domain server.

Using Presence
About this task
The Presence window displays the telephonic activities of other agents in a contact center. From
this window, you can directly contact an agent, transfer a call to an agent, or add an agent to a
conference. Using the Presence window, you can also transfer a Web Chat conversation to an
agent.

The information contains details, such as agent name, agent ID, station ID, station state, and agent
work mode.

Note:
By default, the agent name is displayed in the format <Firstname Lastname>.

To change the format of the displayed agent name, change the Name Order parameter value in the
[presence] section of the asguihost.ini file or on the configuration server. The options
available to change the format of the agent name are:

• Normal or 1: This option displays the agent name in the <Firstname Lastname> format.
• Reverse or 2: This option displays the agent name in the <Lastname Firstname> format.
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Procedure
In the Presence window, right-click an agent record and click the appropriate option such as Dial,
Transfer, or Conference.

Note:

In the Presence window, when you select an agent and click Show history, the system
populates the agent history in the History window.

Directory search options
You can search the directory in the following ways:

Search Description
Database Search This is a comprehensive search that searches the entire directory based on

the contact fields you select in the Search Target Fields drop-down list box,
and specify the search criteria in the Search Criteria field.

The system displays the searched contacts in the Phonebook table.
Smart Search This search automatically highlights the best matched contact based on the

characters you type within the results of the earlier Database search.

You can use Smart Search to find contacts based on the first name or last
name. You must select the Smart Search check box to use this search
option.

Column Search This is a quick search that dynamically searches the contacts by matching
the characters you type with the contents in the Business field.

The system highlights the first contact with a business phone matching the
phone number you type.

You can use Column Search to find contacts based on the business phone.

ASContact database
Call Center Elite Multichannel uses the ASContact database, an SQL-based database, for storing
and maintaining contact details of agents, staff members in a contact center, and the customers of
that contact center.

The ASContact database provides a wide range of fields to store detailed information. An
administrator can select the required fields for a contact. The field structure of the ASContact
database is based on the contact field structure of Microsoft Outlook.

Create a group of related contacts
In the ASContact database, administrator can create a group of related contacts that helps you to
search a contact quickly. You must first add contacts to the ASContact database and then create a
group of contacts. For information about adding a contact and creating a group of contacts, see
Administering Avaya Aura® Call Center Elite Multichannel.
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Based on the size and work load of a contact center, administrator can create groups based on the
department, work area, manager, or administrator.

Administrator can also create groups within groups.

Note:

Even if an administrator adds a contact in a group, the contact remains as an individual record
in a database and the system displays a group as separate record in a directory.

In the Directory window, the contact groups in the ASContact database are displayed in a blue color
with an icon different from the icon of an individual contact. You can double-click a group to list the
associated contacts or groups.

Groups with additional permissions are indicated in bold and in a blue color.

Displaying the entire directory
Procedure

1. In the Directory window, delete the text, if any, from the Search Criteria field.

2. Perform one of the following actions:

• Click Search.

• Press Enter.

Searching a contact in a directory
Procedure

1. From the Search Target Fields drop-down list, select a search target field.

2. In the Search Criteria field, enter the appropriate search criteria.

3. Click Search.

If the search criteria matches with any contacts in the ASContact database, the system
displays contact details of the matched contact in the Phonebook table.

You can right-click the contact record and click an option to perform various actions.

You can view the history of a customer without an active work item by searching the
customer in the Directory plug-in.

Adding a new contact to a directory
Procedure

1. In the Directory window, right-click the Phonebook table and click Add contact.

The system displays a new contact document window.

2. On the General tab, enter the information in the fields.

On this tab, you can change a field name, such as Business address according to your
requirements.
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Note:

For a customer, you must add the full name, the email address, and the phone numbers,
which includes mobile phone number of the contact. This helps you to identify the
customer when you receive a work item from a customer.

3. On the Details tab, enter the information in the fields.

4. Perform one of the following actions:

• Click File > Save to save the new contact.

• Right-click the document and select Save to save the new contact.

• Click File > Save All to save all contacts.

Associating a work item to a contact
About this task
If you receive a work item, the details of which do not match with any contacts in the database, you
can associate the work item to a contact in the database.

Procedure
1. Search the directory for a contact.

2. In the Phonebook table, right-click the contact details and select Associate with Work Item.

Next time, when the same customer contacts, the system displays the contact details on the
work item alert.

Contact phone number formats
If the Smart Dial functionality is enabled, format the contact phone numbers as follows:

• Do not use the following in the phone number:

- PSTN: The code required to dial an outside line.

- STD: The code required to make a national call.

- IDD: The code required to make an international call.

• Use a single space, hyphen, or parentheses to separate area codes from the local number. For
example, 3-4770576, (3) 4770576, or (3)4770576.

• Prefix all country codes with +. For example: +64-3-4770576, +64 (3) 4770576 or
+64(3)4770576.

If the Smart Dial functionality is disabled, you must include the PSTN, IDD, or STD access codes,
the country codes, and the area codes to the phone number. For example: 14770576, 103 4770576
or 10064 3 4770576.

Editing the contact details
Procedure

1. In the Directory window, search a contact.
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2. In the Phonebook table, right-click the contact details and click Open.

The system displays the contact details in a new tab.

3. Edit the required details on the General, Details, and Associated Data tabs.

4. Click the Notes tab to add notes related to a contact.

The Notes tab is a simple text editor, similar to Notepad. You can enter text or copy and
paste text from another application.

The system saves notes for an agent, logged in to the Desktop application. The note title
contains the current date and time and the logged in agent ID.

5. Perform one of the following actions:

• Click File > Save to save the changes for the contact.
• Click File > Save All to save all contacts.

Deleting a contact
Procedure

1. In the Directory window, right-click a contact displayed in the Phonebook table and click
Delete Contact.

2. Click Yes to confirm.

Navigating the directory using keyboard
About this task
In the Directory window, you can navigate the contacts in a directory using keyboard.

Procedure
1. Search the contacts.

The system displays the matched contacts in the Phonebook table.

2. Hold the Control key and press Up or Down arrow.

The system highlights selected contact record in gray color.

Inserting a phone number using keyboard
About this task
When you navigate the contacts list, you can use keyboard to directly insert the phone number of a
contact in the Dial field on the toolbar.

Procedure
1. Select a contact whose phone number you want to insert.

For more information, see Navigating the directory using keyboard on page 51.

2. Press Insert.

The first phone number of the contact is inserted in the Dial field.
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3. Keep pressing Insert to toggle between the other numbers of the contact.

Editing Microsoft Dynamics CRM accounts and contacts
Before you begin
By default, the Microsoft Dynamics CRM Gui plug-in is disabled by preceding it with a semicolon in
the Plug In Assembly List section in the ASGUIHost.ini file. To enable this plug-in, you must
remove the semicolon.

About this task
If an administrator has added Microsoft Dynamics CRM accounts and contacts in the directory, you
can view the accounts and contacts in the Directory window. The Directory window displays the
accounts and contacts as a single or a grouped record with the heading Microsoft Dynamics CRM
Accounts and Microsoft Dynamics CRM Contacts.

To search a Microsoft Dynamics CRM contact or account, see Directory search options on page 48.
For more information, see Displaying the entire directory on page 49 and Searching a contact in a
directory on page 49.

Procedure
1. In the Directory window, right-click a Microsoft Dynamics CRM contact or account and click

Open MS CRM.

The system displays the details of the contact or account in the Microsoft Dynamics CRM
Connector tab.

2. Edit the details and click Save and Close.

3. Click Tools > Options.

4. In the Options dialog box, click the Microsoft Dynamics CRM Connector tab.

5. Click the Synchronization tab.

6. Click Synchronize now.

The system updates the contact details in the directory.

7. In the Directory window, click Search to refresh the contact details.

When you update the contacts in Microsoft Dynamics CRM, the Microsoft Dynamics CRM
Phonebook Synchronizer, which is present on the Microsoft Dynamics CRM server,
automatically updates the ASContact database in real time.

Session notes
You can use the Session Notes window to record notes. You do not need to open an external
application, such as Notepad to record notes.

The notes do not specifically relate to a work-item. The system automatically stores the session
notes in the Rich Text Format (RTF) format. The system loads the session notes every time you
restart the application.
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Note:

You can configure the time interval to automatically save the session notes. Call Center Elite
Multichannel Desktop saves the session notes after every time interval that you have specified.

The session notes are stored in the directory that you have specified in the Call Center Elite
Multichannel Desktop configuration. In the specified directory, you can find the session notes
files with a file name format as: Sessionnotes<Agent ID>.rtf or Sessionnotes.rtf.

If you:

• Logged in to Call Center Elite Multichannel Desktop to receive calls, the Session Notes window
displays the contents of the Sessionnotes<Agent ID>.rtf file, which contains your own
session notes.

• Not logged in to Call Center Elite Multichannel Desktop, the Session Notes window displays
the contents of the Sessionnotes.rtf file. Any agent who can log in to the system can view
the session notes from the Sessionnotes.rtf file.

If an administrator has specified the My Documents folder to store the session notes, and only you
can log in to the system, the Session Notes window also displays notes from the
Sessionnotes<Agent ID>.rtf file. If session notes are stored in a directory other than My
Documents, all the users who can log in to the system can view the notes in the
Sessionnotes.rtf file.

Creating a session note
About this task
Using this procedure, you can create a session note or add data to a session note.

Procedure
1. Open the Session Notes window.

For more information, see Viewing a hidden tool window on page 34.

The system displays the session notes that you have created and saved earlier.

2. In the Session Notes window, enter the session-related notes.

• You can copy text from the notes and paste the text to another application.

• You can paste the text, images into the session notes. Before pasting an image, you must
open an image in an image editor, such as MS Paint, for editing.

• You can separate the notes by putting a line after a note.

3. (Optional) Click the AutoText arrow on the toolbar to insert the autotext phrases.

Note:

The AutoText arrow is enabled only if a work item is open. Do not associate the session
notes to the work item.
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Dialing a phone number from a session note
Procedure

1. In a session note, select a phone number that you want to dial.

2. Right-click the selected number and click Dial.

The system displays the number in the Dial field on the toolbar and makes an outgoing call
to that number. After you receive the voice work item from the dialed number, you can
perform all the telephony functions to that number.

Printing a session note
Procedure
To print a session note, see Printing information on page 43.

Checking the spelling in a session note
Procedure
To check the spelling in a session note, see Checking the spelling of a word on page 40 and 
Checking the spelling in a work item on page 40.

Wallboard
You can use the Wallboard window to view the predefined statistical data of selected agents.

By default, the Wallboard window is located at the top side of the Desktop window.

For information about configuring Wallboard, see Installing Avaya Aura® Call Center Elite
Multichannel.

Viewing error logs
Procedure

1. Perform one of the following actions:

• On the main menu, click Tools > Error log.

• On the main menu, press Control+G.

2. In the Error Log dialog box, click the Clear button to delete the text from the error log.

3. Click OK to save the text and return to the Call Center Elite Multichannel Desktop interface.
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Processing the Microsoft Dynamics CRM activities
Before you begin
Ensure that Microsoft Dynamics CRM Gui plug-in is enabled.

About this task
If the Microsoft Dynamics CRM Gui plug-in is enabled, you can receive Microsoft Dynamics CRM
features, such as task, email, fax, letter, phone call, campaign response, campaign activity, case,
appointment, or service in Call Center Elite Multichannel Desktop.

Procedure
On Call Center Elite Multichannel Desktop, click Answer.

Receiving a Microsoft Dynamics CRM activity is similar to receiving a Call Center Elite Multichannel
work item. For more information, see Accepting a work item on page 39.

Note:

• You cannot answer a Microsoft Dynamics CRM work item by clicking the text on the alert
message that appears at the lower-right side of Call Center Elite Multichannel Desktop.

• Microsoft Dynamics CRM consumes Desktop Memory if you use it with Microsoft Internet
Explorer 8.0. Therefore, ensure that you upgrade to Microsoft Internet Explorer 9.0 or later if
Microsoft Dynamics CRM Plug-in is configured.

Device Media Call Control (DMCC)
DMCC overview

Call Center Elite Multichannel Desktop connects to the Communication Manager deskphone so that
the feature buttons of both products are synchronized. To connect to the Communication Manager
deskphone, Call Center Elite Multichannel Desktop uses DMCC.

For example, EC500 pushed on Avaya H323 or the DCP deskphone configured on Communication
Manager appears on Call Center Elite Multichannel Desktop.

You can put the DMCC buttons on the standard top or bottom toolbar or on the left or right toolbar.
The DMCC plug-in can provide Vu-Stats and Queue information to the Wallboard plug-in. Using
Communication Manager, you can configure the Feature button assignments for each station.

When you use DMCC, a media stream goes to multiple clients. DMCC registers a client application
to control the deskphone and get the media at the same time without unregistering the physical
phone.
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DMCC modes
Main mode

The Main mode implies that the other endpoints can register with Communication Manager using
the same extension. The Main endpoint is not dependent on the registration of any other IP
endpoints using the same extension. After the endpoint joins the call, the endpoint can perform all
related functions, such as Talk and Listen. You can associate only one Main registrant with an
extension.

If the IP endpoint goes through a link bounce, Communication Manager can view the call-present
flag only from the Main mode during registration. If you implement the share-talk button, the Main
mode can block other registrants from taking over the talk-time slot. The Main registrant can also
take over the talk-time slot from the endpoints registered in the DEPENDENT/INDEPENDENT
dependency mode.

Independent mode

In the Independent mode, the endpoints can perform the following functions even when the Main IP
endpoint is not registered:

• Receive call
• Make call
• Talk
• Listen

In the Independent mode, the endpoint has the capabilities of the Main registrant until the Main
endpoint registers. When the Main mode registers or re-registers, the independent registrant is put
in the Listen-only mode and the Main mode gets the talk privilege. The Main mode has precedence
over the Independent mode. The Independent mode is enforced even if the user is in a call.

Note:

If you enable the share-talk button, the talk-time slot remains with the Independent registrar if
the registrar activates the share-talk button. If the Main mode wants to take over the talk-time
slot, then the Main mode must activate this button.

Using the Independent mode, the IP endpoints can specify when the endpoints want to make or
receive calls even if the main endpoint is unavailable in the event of a network failure. The
Independent mode is useful when a call recording application uses the service observing feature
with two registrations for high availability. One registration registers in the Main mode, and the other
registration registers in the Independent mode. In this example, the registrant uses Communication
Manager to either answer calls or make calls after registering.

Dependent mode

In the Dependent mode, an IP endpoint can register only when another endpoint is registered to
Communication Manager using the same extension in the Main mode. IP endpoints can register if
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the extension is with a DCP phone and the DCP phone is in service. During a call, the IP endpoint is
always in the Listen-only mode.

DMCC features

Call Center Elite Multichannel supports the following DMCC features:

• EC500

• Malicious call trace activation

• Malicious call trace controller

• Send all calls

• Call forward

• Auto dial

• Stroke count

• Work codes

• Account

• Vu-Stats

• Headset

• Supervisor Assist

• Busy indicator

• User-to-user information

• VDN of origin repeat

• Mute far-end

• Hunt group night service

• Queued calls

• Oldest queued time

• Bridged appearance

Viewing the application help
Procedure
Perform one of the following actions:

• On the main menu, click Help > Contents.

• On the main menu, press F1.
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Chapter 4: Manage Voice work items

In Call Center Elite Multichannel Desktop, you can:

• Make a call.

• Answer a call.

• End a call.

• Hold a call.

• Divert calls.

• Send Dual Tone Multi Frequency (DTMF) tones.

• Transfer a call.

• Conference a call.

• Drop contacts from a conference call.

• Forward all incoming calls to voice mail or another extension.

• Mute or unmute a call.

• Log in or log off an Agent Station on Communication Manager.

Making a call
About this task
You can call a customer contact that is available in the directory.

Procedure
1. Search contact details in a directory window.

For more information, see Windows on page 31 and Searching a contact in a directory on
page 49.

2. In the directory, right-click a contact record and select Dial > phone number.

Call Center Elite Multichannel Desktop makes an outgoing call to the number that you select.

• If Smart Dial is enabled, Call Center Elite Multichannel Desktop automatically adds the
required national, international access codes to the number. It also removes any
unnecessary national and international access codes added in the number.
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• Call Center Elite Multichannel Desktop ignores any spaces, non-alphanumeric characters,
such as +, ), (, /, $, or %, from the dial string.

• Call Center Elite Multichannel Desktop recognizes alphanumeric numbers. For example, if
you select 1800Avaya, the application converts the number to its numeric equivalent
180028292.

When the call is answered, the state of the call changes to connected.

All the numbers that you dial, appears in the Number to dial field on the toolbar.

3. Dial the number from the Number to dial field:

a. Right-click a contact record and select Use phone number > phone number.

Call Center Elite Multichannel Desktop inserts the selected phone number in the
Number to dial field.

b. Click Dial or press Enter.

4. Dial the number not listed in the directory:

a. In the Number to dial field, enter the destination number.

b. Click Dial or press Enter.

5. Dial the number using the Quick Dial button:

For more information, see Installing Avaya Aura® Call Center Elite Multichannel Guide.

a. If you have set the Quick Dial button for a contact, click the corresponding Quick Dial
button.

The phone number of the contact is inserted in the Number to dial field.

b. Click Dial or press Enter.

6. On the toolbar, click the Work Code arrow and select an appropriate key from the list box to
assign a work code to your work item.

If previewing of work code is enabled, you can hover a mouse over the key for few seconds
to view the value that is assigned to the work item.

Making a call while on another call
Procedure

1. On the Voice toolbar, click Hold if the Dial button is disabled.

The system places your active call on hold.

Note:

Enable the Automatically Hold Active Call On Dial configuration parameter to enable
the Dial button.

Making a call while on another call
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2. Perform one of the following actions:

• In the Number to dial field, enter the destination number and click Dial.
• Right-click a contact record and click Dial > phone number.

Call Center Elite Multichannel Desktop automatically places your active call on hold and
makes an outgoing call. When your call is answered, the call state changes to connected.

3. When you finish your call, click Drop and release.

4. Click Unhold to make the original call active.

If the Make Call Active When Work Item Tab Clicked configuration parameter is:

• Enabled, you can toggle between the calls by clicking the work item tabs. Call Center Elite
Multichannel Desktop makes the call you click as active and put the other call on hold.

• Disabled, you can toggle between the calls by clicking the work item tab and clicking
Unhold on the toolbar.

Making a call from Microsoft Dynamics CRM
Before you begin
Ensure that Microsoft Dynamics CRM Gui plug-in is enabled.

Procedure
Dial the contact number from a Microsoft Dynamics CRM Web page, such as account, contact,
invoice, lead, campaign response, quote, sales order, system user, or phone call.

The Web pages display more than one phone number.

Call Center Elite Multichannel Desktop uses the built-in Smart Dial functionality to extract phone
numbers that are saved inside these activities without any spaces or formatting, for example: - )(+.

Note:

• If you have synchronized your Microsoft Dynamics CRM database with the ASContact
database, you can dial the contacts and accounts through the Call Center Elite Multichannel
Desktop directory.

• Ensure that WindowsMessageRelayer.exe is properly deployed with the Microsoft
Dynamics CRM plug-in to be able to make outbound calls.

Answering a call
About this task
When there is an incoming call, the system displays a voice work item to answer the call.
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Procedure
1. Perform one of the following actions:

• Click Answer from the toolbar.

• Click the text on the voice alert from the lower-right side of your desktop.

Note:

This method of answering a call only works when you enable the Make Call Active
When Work Item Tab Clicked configuration parameter.

When the call connects, more buttons are enabled on the Voice toolbar.

2. On the toolbar, click the Work Code arrow and select an appropriate key from the list box to
assign a work code to your work item.

If previewing of work code is enabled, you can hover a mouse over the key for few seconds
to view the value that is assigned to the work item.

Answering a call while on another call
About this task
If you receive a call when you are on an active call, the system displays an alert for a new voice
work item.

Procedure
1. Perform one of the following actions:

• Click the text on the voice alert from the lower-right side of your computer.

• Click the work item tab.

Call Center Elite Multichannel Desktop places the active call on hold and connects the new
call.

Note:

This method of answering a call works only when you enable the Make Call Active
When Work Item Tab Clicked configuration parameter.

If the Make Call Active When Work Item Tab Clicked configuration parameter is:

• Enabled, you can toggle between the calls by clicking the work item tabs. Call Center
Elite Multichannel Desktop makes the call you click as active and put the other call on
hold.

• Disabled, you can toggle between the calls by clicking the work item tab and clicking
Unhold on the toolbar.
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After enabling this parameter, if the focus automatically shifts to the Work Item tab
because of any other action such as the closure of an active window, then the call is
answered and the work item is accepted.

2. When you finish your call, click Drop and release.

3. Click Unhold to make the original call active.

Placing a call on hold
Procedure
Click Hold on the toolbar.

Making a call active
Procedure
Click UnHold on the toolbar.

Sending DTMF tones
About this task
Sending DTMF tones is required for an Interactive Voice Response (IVR) system, such as
telebanking and voice mail prompts.

When you select a digit in response to a prompt or instruction, the digit is converted into a tone and
passed through the phone network. The prompt or instruction can be a pin number, an account
number, or a selection for a customer choice.

Procedure
1. Make an outbound call to a company that uses an IVR system.

2. When the IVR system answers and prompts you to enter a digit, type appropriate digits in
the Dial field.

3. Click Dial.

4. Repeat steps 2 and 3.

5. Follow all the IVR prompts to complete your outbound call.
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Transfer a call
In Call Center Elite Multichannel Desktop, you can transfer a call using the following methods:

Blind transfer
A call is transferred immediately to the destination.

Consult transfer
A call is transferred after consulting with the destination.

Transferring a call to an available contact in the directory
Procedure

1. Search a contact in the directory.

For more information, see Searching a contact in a directory on page 49.

2. Right-click the contact record and select Transfer > phone number.

Call Center Elite Multichannel Desktop immediately places the original call on hold and
makes a consult transfer call to the number you have selected.

3. If the destination is valid, that is, if a person answers, click the Transfer arrow and select
Complete transfer.

Call Center Elite Multichannel Desktop transfers the active call.

4. If the destination is not valid, that is, if the phone line is busy, no answer from the contact, or
the voice mail of the contact is active, click the Transfer arrow and select Abort transfer.

Call Center Elite Multichannel Desktop ends the consult call.

Transferring a call to an unavailable contact in the directory
Procedure

1. In the Dial field on the voice toolbar, enter the phone number of the required contact.

2. Click the Transfer arrow and select Blind Transfer to immediately transfer the call.

3. To check if the destination is valid before transferring the call:

a. On the toolbar, click the Transfer arrow and select Consult transfer.

Call Center Elite Multichannel Desktop places the original call on hold and makes an
outgoing call to the transfer destination.

b. If the destination is valid, that is, if a person answers, click the Transfer arrow and
select Complete transfer.

Call Center Elite Multichannel Desktop transfers the active call.
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4. If the destination is not valid, that is, if the phone line is busy, no answer from the contact, or
the voice mail of the contact is active, click the Transfer arrow and select Abort transfer.

Call Center Elite Multichannel Desktop ends the consult call.

Conference a call
In Call Center Elite Multichannel Desktop, you can conference a call using the following methods:

Blind conference
A conference destination is immediately joined to the active call.

Consult conference
A conference destination is joined to the active call only after consulting the contact on the
destination.

Note:
In a conference, you can add a maximum of six contacts.

Adding a contact available in the directory
About this task
You can add a contact available in the directory to a conference call.

Procedure
1. Search a contact in the directory.

For more information, see Searching a contact in a directory on page 49.

2. Right-click the contact record and select Conference > phone number

Call Center Elite Multichannel Desktop immediately places the original call on hold and
makes a consult conference call to the selected number.

3. If the destination is valid, that is, if a person answers, click the Conference arrow and select
Complete conference.

The contact becomes active in the conference and the directory numbers of the contacts
already in the conference are displayed to the new contact in the call members list.

4. If the destination is not valid, that is, if the phone line is busy, no answer from the contact, or
the voice mail of the contact is active, click the Conference arrow and select Abort
conference.

Call Center Elite Multichannel Desktop ends the consult call. Click Unhold to resume the
original call.
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Use the above steps to add all required contacts to the conference call.

5. Click Drop and release to disconnect all contacts after you finished the call.

Adding a contact unavailable in the directory
About this task
You can add a contact not listed in the directory to a conference call.

Procedure
1. In the Dial field on the voice toolbar, enter the phone number of the required contact.

2. Click the Conference arrow and select Blind conference to immediately add the contact in
the conference.

3. To check whether the destination is valid before adding the contact to the conference:

a. On the toolbar, click the Conference arrow and select Consult conference.

Call Center Elite Multichannel Desktop places the original call on hold and makes an
outgoing call to the contact that you want to add in the conference.

b. If the destination is valid, that is, if a person answers, click the Conference arrow and
select Complete conference.

The contact becomes active in the conference and the directory numbers of the
contacts already in the conference are displayed to the new contact in the call members
list.

4. If the destination is not valid, that is, if the phone line is busy, no answer from the contact, or
the voice mail of the contact is active, click the Conference arrow and select Abort
conference.

Call Center Elite Multichannel Desktop ends the consult call. Click Unhold to resume the
original call.

Use the above steps to add all required contacts to the conference call.

5. Click Drop and release to disconnect all contacts after you finished the call.

Sending all calls to voice mail
About this task
You can automatically send all incoming calls to your voice mail.

Procedure
1. Click Send All Calls on the toolbar.

2. Click Send All Calls again to disable sending incoming calls to voice mail.

Sending all calls to voice mail
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Forwarding all calls to another number
About this task
You can automatically forward all incoming calls to another number.

Procedure
1. Click Call Forward on the toolbar.

2. In the text box, select the phone number to which you need to forward the call.

3. Click Forward.

4. Click Call Forward again to disable call forwarding.

Recording a call using an agent
Procedure

1. Click Answer on the toolbar to receive the voice work item.

The system enables the Start Recording and Stop Recording buttons.

2. Click Start Recording.

The system starts recording your conversation with the customer.

3. Click Stop Recording.

The system automatically stops recording when you complete a call or disconnect a call.

Recording a call using a supervisor
Procedure

1. On the Supervisor dashboard, right-click an agent ID under the Current Work node to
record a call.

For more information, see Adding a supervisor on page 82.

2. Click Start Recording.

The system starts recording the call of the selected agent.

3. Click Stop Recording.

The system stops recording the call of the selected agent.
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Searching a recorded call
Procedure

1. From the Tools menu, select Replay recording.

The system displays a new tab for the ACR server.

2. In the left pane, select the search parameters, such as date, agent name, customer, and
VDN.

3. Click Search.

The system displays a list of recordings that matches the search criteria.

Replaying a recorded call
Procedure

1. Search a recorded call.

For more information, see Searching a recorded call on page 67.

2. From the list of searched recordings, select the recording that you want to replay.

3. Click the Play button to start replaying the recording.

Releasing a call
Procedure
On the Voice toolbar, click Drop and release.

Leaving a conference call
About this task
If you are in a conference call with multiple participants, and you want to leave the conference,
perform the following action. The other contacts in the conference can continue the call.

Procedure
Click the Drop and release arrow on the toolbar and select Drop me.
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Dropping another contact
About this task
If you are one of the participants in a conference call, you can perform the following action to
disconnect another contact from the call even if you are not the initiator of the conference call.

Procedure
Click the Drop and release arrow and select Drop call with: phone number.

Accessing voice mail
About this task
When you receive a new voice message, the envelope on the Voice Message button changes to
yellow.

Procedure
Click Voice Message on the toolbar.

Call Center Elite Multichannel Desktop dials the voice mail destination number specified in its
configuration.

Processing the Preview Contact work items
About this task
To effectively process the Preview Contact work items, Avaya recommends that you disable the
Bring Forward Work Item If Call Answered By Other Means parameter during the configuration
of Call Center Elite Multichannel Desktop.

Procedure
1. Start and log in to Call Center Elite Multichannel Desktop.

2. Change your work status to Available to receive work items.

Answering a Preview Contact call
Procedure
Perform one of the following actions:

• Click Answer on the toolbar.

• Click the text on the Preview Contact alert from the lower-right side of your desktop.
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The system displays the Preview Contact window with work item details.

The first phone number listed in the contact details is automatically displayed in the Dial field on the
toolbar.

If Smart Dial is enabled, Call Center Elite Multichannel Desktop automatically adds the required
national, international access codes to the number. It also removes any unnecessary national and
international access codes added in the number.

Calling a customer
Procedure

1. Click Dial on the toolbar.

If you have any active call, Call Center Elite Multichannel Desktop places that call on hold
and makes an outgoing call to the customer.

The system displays the call in a new window.

2. If the customer answers, read the campaign prompt.

If the destination is not valid, that is, if phone line is busy, or there is no answer from the
contact, click the outgoing call tab to open the new window and click Drop and release on
the toolbar.

Warning:

Do not click Drop and release when the Document window of your original call is active.
This will close your work item.

3. After you end the call, click the outgoing call tab to open the new window and click Drop and
release.

Assigning a work code to a work item
Procedure

1. Click the Work Code arrow on the toolbar and select the appropriate key from the available
option.

Note:

If an administrator has enabled Work Code previewing, you can hover the mouse over
the key for few seconds to preview the value that is assigned to your work item.

2. To add or update any additional information associated with this contact, do it in the
Additional Information section of the work item.
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Printing information related to a work item
About this task
You can print information related to a selected work item.

Procedure
1. Perform one of the following actions:

• Click Print the current work item on the toolbar.

• From the Edit menu on the menu bar, click Print.

The system displays the Print dialog box.

2. In the dialog box, select the required printing options and click Print.

If more than one window is associated with an open work item, the system prints information
from each window and separates it by a line.

Updating the work status
About this task
You can update the status of interaction with a customer and close the work item.

Procedure
1. Click Close the work item arrow on the toolbar and select the appropriate work status.

For information about the work status options, see Work status options on page 70.

Alternatively, you can click the cross button on the work item to close it. In this case, the
default option 1 Completed Success is selected.

Note:

If you have logged in as an Auto-In agent, Call Center Elite Multichannel Desktop
automatically changes your work mode to Available mode.

If you have logged in as a Manual-In agent, change your work mode to After Call Work.

2. Click Available on the toolbar to receive another call.

If at any time during an active call you click the tab for the outgoing call and then click back
to the original work item, your outgoing call might be put on hold. To resume the call, you
must click the outgoing call tab again.

Work status options
The following table describes the different work status options.
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Option Description
1 Completed Success The customer was contacted and the work completed

successfully.
2 Completed Failed The attempt to reach the contact failed. This task is retried with

future campaign schedules.
3 Completed No Retry The customer was contacted and the work completed

successfully.

Further attempts to reach this contact should not be made
because of the request from the customer.

4 Failed The attempt to reach this contact failed.

Further campaign schedules should not attempt to reach this
contact because of an invalid phone number.
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Chapter 5: Manage Email work items

Processing Email work items
Procedure

1. Start and log in to Desktop.

2. Change you work status to Available to receive work items.

Answering an email
Procedure
Perform one of the following actions:

• Click Answer from the toolbar.
• Click the text on the email alert from the lower-right side of your desktop.

The system displays work item details in a new document window.

Note:

Call Center Elite Multichannel Desktop supports
the .zip, .tar, .pdf, .jpg, .tif, .txt, .doc, .xls, .htm, .vsd, .exe, .lvp, .wav, and .mp3 attachment
types.

Replying to an email
Procedure

1. Perform one of the following actions:

• Click Reply to email from the toolbar.
• Click Reply from the Email menu on the menu bar.

In the configuration of Email Media Store, if the Include Original Email parameter is
enabled, Call Center Elite Multichannel Desktop automatically inserts the content of the
original email into the reply. If the Edit Original Email parameter is enabled, the original
email appears in the same editable window as the replied message.

If both the parameters are disabled, the window is split with the original email in the lower,
non-editable, pane and the replied message in the upper, editable, pane.
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2. To insert the content of an email template, click where you want the text to appear, select the
template from the Template window, which previews the template and click Add Template.

3. Enter the message in the message field.

Sending an email to another recipient
Procedure

1. Search a contact in the Directory tool window.

For more information, see Searching a contact in a directory on page 49.

2. Depending on your requirement, perform the following actions:

• Right-click the contact record and select Send Email to > email address.

• Right-click the contact record and select Cc Email to > email address, if you want to
send a copy of the message to another recipient with the name of that recipient visible to
other recipients of the message.

• Right-click the contact record and select Bcc Email to > email address, if you want to
send a copy of the message to another recipient with the name of that recipient invisible to
other recipients of the message.

Attaching a file to an email
Procedure

1. Perform one of the following actions:

• Click Attach file from the toolbar.

• Select Attach from the Email menu on the menu bar.

2. Browse to the location and select a file.

Note:

Call Center Elite Multichannel Desktop supports
the .zip, .tar, .pdf, .jpg, .tif, .txt, .doc, .xls, .htm, .vsd, .exe, .lvp, .wav, and .mp3
attachment types.

3. Click Open.

Note:

While attaching a file, ensure that the file is not open. Otherwise, the file might not get
attached correctly.
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Sending an email reply and returning to the original work item
Procedure
Perform one of the following actions:

• Click Send email form the toolbar.

• Select Send from the Email menu on the menu bar.

Forwarding an email to a resident expert
Procedure

1. Perform one of the following actions:

• Click Forward to resident expert on the toolbar.

• Select Forward to resident expert from the Email menu on the menu bar.

2. Click the To field to select a resident expert.

3. Select the Reply Directly to Customer check box to ensure that the system directly sends
the reply from the selected resident expert to customer.

Note:

If you do not select the Reply Directly to Customer check box, the system sends the
reply from the resident expert to the Media Director for redistribution to the next available
agent.

4. Select an email template in the Template window if you want to insert the content of an email
template, and click Add Template.

5. Type your message in the email body.

6. Click Send Email on the toolbar.

Note:

If, Advanced WorkCode is configured, then the agent must press the Send button again
after entering the Advanced WorkCode.
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Chapter 6: Manage Simple Messaging work
items

Processing Simple Messaging work items
Procedure

1. Log in to Desktop.

2. Change your work status to Available to receive work items.

Releasing a call while working on a Web Chat conversation
Procedure
Click Drop and release from the toolbar to release a call and make your station Available.

If you have logged in as an Auto-In agent, Call Center Elite Multichannel Desktop automatically
changes your work mode to Available mode.

If you have logged in as a Manual-In agent, change your work mode to After Call Work.

You can use this method of releasing each call to receive and work on several work items
simultaneously.

Customer contact through Web Chat
When a customer initiates a Web Chat conversation, the customer is presented with the Web Chat
interface of Call Center Elite Multichannel Desktop.

Note:

The Web-based chat application is provided in the Call Center Elite Multichannel installer. An
administrator must install the application on the Web server.

To initiate a conversation, a customer must first type the customer name, optional department, and
an initial question on the Web Chat interface, and then click Launch Conversation. The Web Chat
gateway sends the request to Simple Messaging Media Store. After receiving the request, Simple
Messaging Media Store creates a work item and passes the work item to Media Director. Media
Director then distributes the work item to an appropriate agent.
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Web Chat offers Date and Timestamp and Typing Notification features to customers and agents. In
addition, Web Chat offers Chat Transfer feature to agents.

Note:

In a Web Chat conversation, if you type multiple spaces between two words, the system
automatically replaces multiple spaces with a single space.

Date and Timestamp
During a conversation between a customer and an agent, the customer and the agent see a
conversation timestamp according to their respective local time zones. However, the server stores
the conversation timestamp according to the UTC time zone. If an agent attempts to view the
conversation history from the server, the conversation timestamp is converted according to the local
time zone of the agent.

During the conversation, if the date changes at the agent end but remains unchanged at the server
end, the Web Chat work item window of the agent displays the new date while the server stores the
conversation according to the current date on the server. The customer and the agent see the
information related to day, month, and year in their local languages.

Note:

• The Date and Timestamp feature is applicable to all Simple Messaging Media Store
gateways.

• The conversation history displays information about the date and time only after you
upgrade to Call Center Elite Multichannel 6.4 or later version.

Important:

Ensure that the time on the following systems is synchronized:

• Call Center Elite Multichannel Reporting Desktop or Call Center Elite Multichannel Desktop
of all agents

• Call Center Elite Multichannel core server

• Call Center Elite Multichannel database server

This synchronization is mandatory to get the correct results. To synchronize the time, you can
use an NTP server or a domain server.

Typing Notification
During a Web Chat conversation between a customer and an agent, the customer and the agent
receive the following notifications:

• When the customer types text, the agent receives a notification stating: <Customer Name>
is typing....

• When the agent types text, the customer receives a notification stating: Agent is
typing....
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• When the customer stops typing for more than 5 seconds, the agent receives a notification
stating: <Customer Name> has entered text.

Note:

The Typing Notification feature is applicable only to the Web Chat gateway.

Chat Transfer
During a Web Chat conversation between a customer and an agent, the agent can transfer the
conversation to a queue or another agent. After the agent transfers the conversation, the current
conversation between the agent and the customer ends.

When the agent transfers the conversation to a specified agent, the conversation goes to that agent
only if the agent is available to receive the conversation. If the specified agent is unavailable for
more than 4 minutes, the conversation gets re-queued and delivered to any available agent in the
queue.

Note:

• The 4 minutes time is the default configuration value. You can edit the Maximum Time In
Agent Queue Seconds parameter in the ASMediaDirector.ini file to specify the time
for which the transferred conversation must wait for the availability of the agent. For more
information about the ASMediaDirector.ini file, see Administering Avaya Aura® Call
Center Elite Multichannel.

• An agent can transfer a conversation to another agent only if Direct Agent calling is
configured in Communication Manager.

After an agent receives the transferred conversation, the Web Chat work item window of the agent
displays a top pane and a bottom pane. The top pane displays the chat transcript history and the
bottom pane displays the current conversation between the agent and the customer.

Important:

Ensure that the time on the following systems is synchronized:

• Call Center Elite Multichannel Reporting Desktop or Call Center Elite Multichannel Desktop
of all agents

• Call Center Elite Multichannel core server

• Call Center Elite Multichannel database server

This synchronization is mandatory to get the correct results. To synchronize the time, you can
use an NTP server or a domain server.

Transferring a conversation
About this task
Using this procedure, an agent can transfer a conversation to a queue or another agent.

Procedure
1. On the Web Chat work item window, click Transfer.
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2. In the Select a Transfer Destination dialog box, perform one of the following steps to transfer
the conversation to a queue:

a. In the Destination field, click Queue.

The system displays the list of queues.

b. (Optional) Click Refresh to refresh the list of queues.

c. Click a queue from the list.

d. Click OK.

3. In the Select a Transfer Destination dialog box, perform one of the following steps to transfer
the conversation to an agent:

a. In the Destination field, click Agent.

The system displays the list of agents. In the list of agents, the Agent Name field
displays the name of the agent only if you configure the Presence plug-in and the agent
details are available in the contact database. If you do not configure the Presence plug-
in or the agent is not available in the contact database, the Agent Name field displays
the name of the agent as SYSTEM.

b. (Optional) Click Refresh to refresh the list of agents.

The list contains all agents that are currently logged into Media Director.

c. Click an agent from the list.

d. (Optional) In the Search field, enter the text to search an agent in the list.

When you enter the text, the first agent that matches the search criteria is selected
automatically.

e. Click OK.

After a successful transfer, the Web Chat work item window of the agent displays:

• A message confirming the transfer of conversation.

• A message indicating the end of the conversation between the current agent and the
customer.

After a successful transfer, the Web Chat interface of the customer displays:

• A message indicating that the system is transferring the conversation to another agent.

Customer contact through Google Hangouts
When a customer uses the Google Hangouts messenger to communicate with you, the customer
must add one of the services of the contact center to the customer contact list. Instant Messenger
automatically displays the Gmail address of the service in the gateway configuration of Google
Hangouts messenger.
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The customer initiates a conversation by double-clicking the service they want to contact. The
system displays the Instant Message dialog box in which the customer enters a question and clicks
Send.

The Google Hangouts messenger gateway sends the request to Simple Messaging Media Store,
which creates a work item and passes the work item to Media Director. Media Director then
distributes the work item to an appropriate agent.

Customer contact through SMS
Customers can communicate with you using a Short Message Service (SMS). To initiate a
conversation, customer sends an SMS to a specific number in a contact center from their mobile
phone.

The SMS gateway sends the request to Simple Messaging Media Store, which creates a work item
and passes the work item to Media Director. Media Store distributes the work item to an appropriate
agent.

Answering a chat call
Procedure

1. Perform one of the following actions:

• Click Available from the toolbar.

• Click the text on the chat alert from the lower-right side of your desktop.

The system displays the work item details in a new document window.

2. In the message field, type your response.

3. (Optional) Insert a predefined phrase in the body of your work item.

For more information, see Inserting an autotext entry on page 39.

4. Use the spell checker to check the spelling in your work item.

For more information, see Checking the spelling of a word on page 40 and Checking the
spelling in a work item on page 40.

5. Click Send.

The customer can type a reply and click Send.

Note:

Call Center Elite Multichannel Desktop displays the emoticons that a customer sends
using an IM application. You can also send an emoticon to the customer by using a
keyboard to type a key combination associated with an emoticon, for example, :).

6. Repeat the steps until you complete the conversation with the customer.
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7. Close the work item.

For more information, see Closing a work item on page 43.
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Chapter 7: Supervisor plug-in

Supervisor is a plug-in with which you can monitor the call activity of an agent or a group of agents.

Using the plug-in, integrated with Call Center Elite Multichannel Desktop, you can:

• View or change the current state of an agent.
• Join a call as an observer in which you can hear the conversation without an agent and

customer knowing that you have joined the call.
• Join a call as a coach in which you and an agent can communicate with each other without the

customer knowing that the agent is interacting with you.
• Join a call as a participant in which an agent, a customer, and you can communicate with each

other.
• Log out an agent.

Note:

In the Supervisor window, when you select an agent and click Show history, the system
populates the agent history in the History window.

Additionally, if an administrator has configured the Interaction Data Server - View client for Desktop,
you can:

• View statistics about the average length of time an agent spends in the After Call Work (ACW)
and the Available modes.

• View statistics about the number of calls an agent received.

In Call Center Elite Multichannel Desktop, the plug-in displays data in a simple tree structure and
uses colors to indicate information about agents and calls.

Note:

Realtime and Historical reports do not count a call or talk state when a Supervisor joins the call
(all modes) through Supervisor Desktop.

Adding a supervisor requirements
Before you add a supervisor tab, ensure the following:

• A group of agents is created in the ASContact database using Call Center Elite Multichannel
Control Panel. A supervisor can monitor the activities of the agents in the group.
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Note:
You can monitor activities of an agent only when the corresponding agent ID is specified in
the ASContact database.

• In the Options dialog box:

- The Directory tab displays correct values for the ASContact database.
- The IDS View Client tab displays the correct IDS View URL and IDS View Client is properly

connected. With this, the supervisor can view the statistics of all agents.
- The Telephony tab displays the correct XML server IP address and telephony link is

successfully connected to the XML server. With this, the supervisor can monitor the stations
and the agents.

Note:
In Call Center Elite Multichannel Desktop, the Dashboard plug-in is a very useful and
powerful tool, where you can view agent details in an organized manner. You can
simultaneously view the activities of four groups of agents.

Adding a supervisor
About this task
As a supervisor, you can add a supervisor tab on the dashboard to monitor the activities of an agent
or a group of agents.

Procedure
1. In Desktop, click Tools > Options.

2. Click the Dashboard tab.

3. On the Dashboard tab, click Add.

4. Enter the values as described in Adding a supervisor field descriptions on page 82.

5. After you complete all settings, click Apply and then click OK.

Supervisor tab displays single or multiple agent groups. For information about the nodes that
are displayed for each agent, see Supervisor monitoring information on page 83.

Note:

By default, the agent name is displayed in the format <Firstname Lastname>. To change
the format of the displayed agent name set the Name Order configuration value in the
User Control section of the dashboard in asguihost.ini file to Reverse or 2.

Adding a supervisor field descriptions
The following table describes the field descriptions of adding a supervisor.
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Field Description
Display name The name that appears on the supervisor tab. For example, Supervisor.
Enable close button A cross button that appears on the top-right corner of the supervisor tab.

Clicking this button closes the supervisor tab.
Lock Layout Locks the panel layout.

If you select this option, you cannot resize the panels for agents groups
that you monitor.

If you do not select this option, you can resize the panels for agents
groups.

To resize the panels, you need to hold a mouse pointer between the two
panels and when the mouse pointer changes to a double-headed arrow,
drag it to the required side.

Panel Layout In this area, you can select an option to arrange multiple dashboard
content panels on the Supervisor tab. These dashboard content panels
represent different groups of agents that you can monitor.

Following are the options available:

• Single: Displays only one panel.

• 1 left 1 right: Displays one panel at the left and one panel at the right.

• 1 top 1 bottom: Displays one panel at the top and one panel at the
bottom.

• 2 top 2 bottom: Displays two panels at the top and two panels at the
bottom.

• 1 top 2 bottom: Displays one panel at the top and two panels at the
bottom.

• 2 top 1 bottom: Displays two panels at the top and one panel at the
bottom.

Dashboard Content Depending upon the options you select for Panel Layout, these drop-
down list boxes are enabled.

Select Supervisor from the drop-down list and click the corresponding
button.

For information about the options on the Supervisor dialog box, see 
Adding agent groups field descriptions on page 85.

The supervisor tab displays the groups that you select on the Supervisor
dialog box for each dashboard content.

Supervisor monitoring information
The following table describes the nodes that are available for a supervisor to monitor the
information. These nodes contain sub-nodes for agent and phone. In these sub-nodes, a supervisor
can view the respective information in real time.

Adding a supervisor requirements
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Node Description
Agent Group This is the first level node, which represents the agent group name that you can

monitor. In this node, supervisor can monitor call and agent related information in
the Phone and Agent sub-nodes respectively.

Phone This is the second level node. This node displays the call details of an agent
group that you are monitoring.

This node contains the following sub-nodes:

• Current Work: Displays the number of voice calls an agent is currently
handling from their phone.

• History: Each Call Node has a single child node for each call currently at the
agent device. The Active Call Node text indicates the call state, the direction of
the call, and the phone number of the other call party.

Agent This is the second level node. In this node, you can monitor the agent work mode
and the statistical work details of an agent.

When an agent logs in to the application, this node displays the agent name and
the agent ID.

This node contains the following sub-nodes:

• Agent work mode: Displays the work modes, such as Logout, AUX, Available,
or ACW, of an agent.

• Agent statistics: Displays the statistical data about an agent. The data is
retrieved from the Interaction Data Server - Voice and Presence.

This node is not displayed, if the connection to the Interaction Data Server -
Voice and Presence is not configured or not available. In agent statistics, you
can monitor the following details:

• Agent ACW: Displays the average length of time, in seconds, that an agent
spends in the ACW mode. The time is calculated above the interval specified in
the Interaction Data Server - Voice and Presence.

• Avg. Available: Displays the time average length of time, in seconds, an agent
is in the Available mode. The time is calculated above the interval specified in
the Interaction Data Server - Voice and Presence.

• Calls received/interval: Displays the total number of calls that an agent has
received during the interval specified in the Interaction Data Server - Voice and
Presence.

Note:

The statistic interval is the time in minutes between statistic calculations. The
interval, which is set in the Interaction Data Server - Voice and Presence can
be between 1 and 60 minutes.

For more information about the interval, see Administering Avaya Aura® Call
Center Elite Multichannel Guide.

Supervisor plug-in
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Adding agent groups field descriptions
The following table describes the field descriptions of adding agent groups.

Name Description
General Options
Display title The name of an agent group. For example, HR, Administration, or

Finance. The system displays the title at the top-left side of the
panel.

Supervisor group name The name of an agent group from the ASContact database. You
can monitor activities of agents only from these groups.

Maximum group members The maximum number of agents that the system displays in a
group. Default: 10.

Column Names In Database
Station DN The database column name from where Presence gets the

station DN of each contact. The default is BusinessPhone.
Agent ID The database column name from where Presence gets the agent

ID of each contact. The default is OtherPhone.
Time Display Style
Seconds only Displays time in seconds.
Minutes and seconds Displays time in minutes and seconds.
Call Functions
Allow service observe This option makes the Allow Service Observe menu item

available to you when you right-click an active call. The default is
True.

For more information, see Joining a call as an observer on
page 86.

Allow join call This option makes the Allow Join Call menu item available to
you when you right-click an active call. The default is True.

For more information, see Joining call as a participant on
page 87.

Allow join as coach This option makes the Allow Join As Coach menu item available
to you, when you right-click an active call. The default is True.

For more information, see Joining a call as a coach on page 87.
Agent Functions
Allow set agent state This option makes the Allow Set Agent State menu item

available to you, when you right-click the agent work mode. The
default is True.

For more information, see Setting an agent on page 87.

Table continues…
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Name Description
Allow log agent out This option makes the Allow Logout Agent menu item available

to you, when you right-click the agent work mode. The default is
True.

For more information, see Logging out an agent on page 87.
Call Node Color Scheme
Service observe call node color The color that is used to display a call node when you join call as

an observer
Join call call node color The color that is used to display a call node when you join a call

as a participant.
Join as coach call node color The color that is used to display a call node when you join a call

as a coach.
Reason Codes
Logout reason code The reason code that is used when you attempt to log an agent

out. The default is 9.
Auxiliary reason code The reason code that is used when you attempt to put an agent in

the AUX mode. The default is 8.
Error Log
Enable error logging This option enables the application to store the plug-in related

error information to the error log files.
Show History
Enable show history If you select this check box, the system enables the Show History

option in the Supervisor window.
Enable docking on show history If you select this check box, the system enables docking of the

History window on Call Center Elite Multichannel Desktop.

Supervisor functions
Supervisor can observe a conversation of an agent with a customer, help an agent resolve queries,
or actively participate in a conversation that an agent has with a customer.

Joining a call as an observer
About this task
To monitor the conversation between an agent with the customer, supervisors can join a call as an
observer. Supervisors can listen to the conversation between an agent and a customer without the
agent and the customer being aware that the supervisor is on the call.

Procedure
Right-click an active call node and select Service observe.

Supervisor plug-in
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Joining call as a participant
About this task
To participate in a call between an agent and a customer, supervisors can join the call as a
participant. In this, the agent, the customer, and the supervisor can communicate with each other.

Procedure
Right-click the active call node and select Join call as participant.

Joining a call as a coach
About this task
To join a call to help an agent, supervisors can join a call as a coach. Supervisors can communicate
with an agent without the customer being aware that the supervisor and the agent are interacting.

Procedure
Right-click the active call node and select Join as coach.

Dropping from a call
Procedure
Right-click the active call node and select Drop me from call.

Setting an agent
About this task
As a supervisor, you can set the working state for an agent. You can place an agent in the AUX,
ACW, or Available mode.

Procedure
Right-click the Agent work mode node and select Set agent state > agent state.

Logging out an agent
About this task
Being a supervisor, you can log an agent out.

Procedure
Right-click the Agent work mode node and select Log agent out.

Viewing the history of an agent
Procedure
In the Supervisor window, right-click the agent name and click Show history.

The system populates the agent history in the History window.

Adding a supervisor requirements
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Chapter 8: Resources

Documentation
The following table lists the related documents for the Avaya Aura® Call Center Elite Multichannel
product. You can download the documents from the Avaya Support website at http://
support.avaya.com/.

Title Description Audience
Avaya Aura® Call Center Elite
Multichannel Call Routing Server
User Guide

Provides an overview of Call
Routing Server that enables
intelligent call routing for
inbound calls in Call Center
Elite Multichannel.

• Sales engineers

• Solution architects

• Implementation engineers

• System administrators
Installing Avaya Aura® Call Center
Elite Multichannel

Provides product overview,
supported products,
installation, configuration, and
licensing requirements for
Avaya Aura® Call Center Elite
Multichannel.

• Implementation engineers

Avaya Aura® Call Center Elite
Multichannel Configuration Client
Developer Guide

Provides information about
the Configuration Client
Developer application, which
is a control that facilitates an
application to transparently
access the configuration
information from any location.

• Programmers

Administering Avaya Aura® Call
Center Elite Multichannel

Provides information about
how to manage databases,
configure Call Center Elite
Multichannel services, and
administer Avaya Aura®

Communication Manager.

• Sales engineers

• Solution architects

• Implementation engineers

• System administrators

Avaya Aura® Call Center Elite
Multichannel Overview and
Specification

Provides an overview of the
Call Center Elite Multichannel
features.

• Sales engineers

• Implementation engineers

• System administrators

Table continues…
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Title Description Audience
Avaya Aura® Call Center Elite
Multichannel Application
Management Service User Guide

Provides information about
how to install and administer
Application Management
Service in Call Center Elite
Multichannel.

• Sales engineers

• Solution architects

• Implementation engineers

Avaya Aura® Call Center Elite
Multichannel Upgrade and Migration
Guide

Provides information about
how to upgrade or migrate
Avaya Aura® Call Center Elite
Multichannel from Release
6.2.x, 6.3.x, or 6.4.x to
Release 6.5.

The Upgrade Sequence
section in the respective
upgrading chapters provides
a high-level overview of the
process.

• Implementation engineers

• Solution architects

Avaya Aura® Call Center Elite
Multichannel Reporting User Guide

Provides information about
the reports for Agents,
Customers, Interaction,
Program and Schedule,
Skills, and VDNs. This guide
also provides information
about historical reports and
real-time reports.

• Sales engineers

• Solution architects

• Implementation engineers

Avaya Aura® Call Center Elite
Multichannel TTrace User Guide

Provides information about
TTrace and its components,
helps you to understand the
TTraceConsole and
TTraceConfig user interfaces,
and explains the operations
that you can perform using
TTraceConsole and
TTraceConfig.

• Sales engineers

• Solution architects

• Implementation engineers

Finding documents on the Avaya Support website
About this task
Use this procedure to find product documentation on the Avaya Support website.

Procedure
1. Use a browser to navigate to the Avaya Support website at http://support.avaya.com/.

2. At the top of the screen, enter your username and password and click Login.

3. Put your cursor over Support by Product.

Documentation
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4. Click Documents.

5. In the Enter your Product Here search box, type the product name and then select the
product from the drop-down list.

6. If there is more than one release, select the appropriate release number from the Choose
Release drop-down list.

7. Use the Content Type filter on the left to select the type of document you are looking for, or
click Select All to see a list of all available documents.

For example, if you are looking for user guides, select User Guides in the Content Type
filter. Only documents in the selected category will appear in the list of documents.

8. Click Enter.

Training
The following courses are available on the Avaya Learning website at http://www.avaya-
learning.com. After logging in to the website, enter the course code or the course title in the Search
field and press Enter or click > to search for the course.

Course code Course title
5C00092W Avaya Aura® Call Center Elite Multichannel Overview
10C00010E Knowledge Access: Avaya Aura® Call Center Elite Multichannel Implementation
10C00094V Avaya Aura® Call Center Elite Multichannel Implementation and Maintenance
4302 Avaya Aura® Call Center Elite Multichannel Implementation Test
0C00060E Knowledge Collection Access: Avaya Aura® Call Center Elite Portfolio
E: Self-paced in virtual campus

W: Web (online) course

V: Virtual

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot Avaya
products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

Resources
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Procedure
• To find videos on the Avaya Support website, go to http://support.avaya.com and perform one

of the following actions:

- In Search, type Avaya Mentor Videos to see a list of the available videos.

- In Search, type the product name. On the Search Results page, select Video in the
Content Type column on the left.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and
perform one of the following actions:

- Enter a key word or key words in the Search Channel to search for a specific product or
topic.

- Scroll down Playlists, and click the name of a topic to see the available list of videos posted
on the website.

Note:

Videos are not available for all products.

Support
Go to the Avaya Support website at http://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.

Support
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Appendix A: Toolbars and menus

The Call Center Elite Multichannel Desktop interface contains toolbars that you can use to manage
multimedia work items.

You can use the toolbars to:

• View information related to a contact item and a work item.

• Complete tasks and update the work item status.

A toolbar consists of buttons and menus that you can use to set up your work environment, handle
work items, and update the status of each work item.

About the toolbars
The following components have toolbars:

• Voice

• Email

• User

• AutoText

• Work Code

On each component toolbar, you can click buttons to perform an action or click menus to select an
option before performing an action.

Toolbar buttons
You can configure the position of the toolbar on the Options dialog box from the Tools menu.

When you place the cursor over a button, the system displays a tooltip in a box near the button. This
tooltip indicates the name of the button. To perform an action, click the corresponding button on the
toolbar.
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Toolbar menus
Toolbar menus are the buttons with a down arrow at the right side.

You can click the button to perform an action or the down arrow to view the menu options and
submenus for the tasks that are associated with the button.

Context menus
Desktop displays a context menu when you right-click on a user interface control. The Context
menu is a popup menu that displays options for the selected UI control.

You can select a Context menu option instead of the corresponding function on the toolbar or menu
bar.

User toolbar

The User toolbar consists of buttons and menus that you can use to perform the following tasks:

• Change your work status to Available to receive work items.
• Log in and log out of the application.
• Set your working preferences.
• Exit the application.

The following table describes the buttons that appear on the User toolbar.

Icon Button Description
Agent Login You can log in to the Desktop application.

Agent Logoff You can log out form the Desktop application.

Auxiliary You can change your work mode to Auxiliary (AUX). The
AUX mode indicates that you have taken a break, for
example, lunch break.

After Call Work You can change your work mode to After Call Work (ACW).
The ACW mode indicates that you are doing an after call
work, such as updating notes or filling forms.

Available You can change your work status to Available to receive
work items.

Context menus
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Email toolbar

The Email toolbar consists of buttons and menus that you can use to perform actions related to the
email work items.

The following table describes the buttons that appear on the Email toolbar.

Icon Button Description
Save Email Saves an email.

Reply to Email Opens a new tab for you to reply to an email that you
receive from a customer.

In the new email tab:

• The Subject field displays the subject from an email that
you received.

• The To field displays the email address of a customer
from whom you received the email.

• The email body displays two sections, separated with a
separator. You can drag this separator to resize the
sections.

The lower section displays the original email. You can
enter your response to the customer query in the upper
section.

The arrow button (  / ) on the right side of the From
field shows and hides a part of the information from the
upper section. The purpose of hiding the information
from the upper section is to provide larger area for the
original email.

Note:

The button is enabled only when you have an active
email work item.

Reply to All Recipients Opens a new tab for you to reply to the email that you
receive from a customer. The email is sent to all the email
addresses mentioned in the original email.

The functionality of this option is same as the Reply to
Email option. The To, Cc, and Bcc fields show the same
email address from the original email.

Forward Email Opens a new tab for you to forward this email to another
person. For example, supervisor or another contact.

You can enter the email addresses in the blank To, Cc,
Bcc fields to forward this email.

Table continues…

Toolbars and menus
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Icon Button Description
Forward to Resident
Expert

Opens a new tab for you to send an email to a Resident
Expert.

You must send an email to a Resident Expert when you
are unable to understand a customer query or when
advance skills are required to resolve a customer query.

In the new email tab:

• The To field changes to a drop-down list. You can select
the email address of a Resident Expert from the drop-
down list.

• The Cc, Bcc, and Subject fields are disabled for editing.

• You can select the Reply directly to customer check
box, so that the Resident Expert can send the email to
the customer.

Send Email Sends a new active email or an active email that you are
replying to or forwarding to a customer or a Resident
Expert.

After you send an email from the Desktop application, the
tab of the original email work item becomes active.

This button is enabled only when the tab of an email that
you are sending, replying, or forwarding is active.

When you perform one of the following steps, all outbound
emails are sent in HTML format irrespective of the format
of inbound emails:

• In the ASEmailMediaStore.ini file, set the Send
Email As HTML Format parameter to True.

• In Call Center Elite Multichannel Control Panel, edit an
EMS queue and select the Send Email As HTML
Format check box.

However, an outbound email is sent in Plain Text when you
explicitly select the option to send the email in Plain Text.

Attach File Opens the file Open dialog box to select a file that you
want to attach to an email.

The Attachment field displays all the files that you have
attached.

To remove an attached file, you can select a file and press
Delete. You can also right-click a file and select Remove
attachments.

Spell Check Checks the spellings of the text entered in the email body.

Email toolbar
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Voice toolbar

The Voice toolbar consists of buttons and menus that you can use to perform actions related to the
voice work items that you receive.

The following table identifies and describes the buttons that appear on the Voice toolbar:

Icon Button Menu option Description
Voicemail Displays the voice mail messages that

you received.
Send All Calls Forwards all voice work items to a

predefined destination.
Forward Call Forwards an active voice work item to a

number that you specify in the Forward
to field.

Dial field and
Dial pad

Displays the phone number of a contact.

When you click the Dial pad, the system
dials the phone number displayed in the
Dial field.

Send DTMF
tones

Sends Dual Tone Multi Frequency
(DTMF) tones required for an Interactive
Voice Response (IVR) system, such as
telebanking and voice mail prompts.

Answer Answers an active work item.

Hold Puts an active voice call on hold.

You must use the Hold option when you
want to transfer the call, conference the
call, or discuss a customer query with
your supervisor.

Unhold Resumes a voice call that is on hold.

You can start communicating with the
person on the call.

Transfer • Blind Transfer

• Consult Transfer

• Complete Transfer

• Abort Transfer

Transfers an active voice call to another
number. For example, another agent or a
supervisor.

Conference • Blind Conference
• Consult Conference
• Complete

Conference

Adds a contact to an active conference.

Table continues…

Toolbars and menus
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Icon Button Menu option Description
• Abort conference

Drop and
Release

Drops the current voice call.

Start
Recording

Starts recording a voice call.

Stop
Recording

Stops recording a voice call.

AutoText and Work Code toolbar
AutoText and Work Code are single button toolbars with a down arrow on each button.

You can click AutoText to display the autotext entries that an administrator has configured in
Control Panel. You can click an autotext entry to insert the entry in your work item, session notes, or
work item notes.

You can click Work Code to view the work codes that an administrator has configured in Control
Panel. You can click a work code to assign the work code to your work item.

Icon Button Description
AutoText Displays the autotext entries that an administrator has

configured in Control Panel.
Work Code Displays the work codes that an administrator has

configured in Control Panel.

Media Client toolbar
The following table lists and describes the buttons that appear on the Media Client toolbar.

Icon Button Description
Station Login/
Station Logout

Registers or unregisters an Agent Station on Communication
Manager. Call Center Elite Multichannel Desktop displays
this button only when the Media Client plug-in is enabled.

Mute Audio/Unmute
Audio

Mutes or unmutes a call.

To use these buttons, you must configure the Media Client plug-in through Tools > Options dialog
box. For information about how to configure the Media Client plug-in, see Installing Avaya Aura®

Call Center Elite Multichannel.

Note:
• Media Client is not supported in Citrix and Virtualized environments.

AutoText and Work Code toolbar
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• Media Client does not support SIP station.
• Do not log to the same station on the same Desktop simultaneously through Call Center

Elite Multichannel Media Client and Avaya one-X® Agent/Avaya one-X® Communicator.
• When Call Center Elite Multichannel Media client is configured on Agent Desktop, agent

cannot add collected digits while transfer or conference of calls.
• The DMCC plug-in functionality does not work with Media Client plug-in.

Shortcut keys
Call Center Elite Multichannel Desktop offers the following shortcut key combinations.

Shortcut Action
Control+P Print.
Alt+S Send email.
Alt+R Reply to email.
Control+G View error logs.
F1 Display online help.
F7 Check spelling.
Control+Home Dial a phone number.
Control+Page Down Place a call on hold.
Control+Page Up Resume a call that is on hold.
Control+Delete Drop me from a call.
Control+End Release a call.
Control+Shift+Q Initiate a blind transfer.
Control+Q Initiate a consult transfer.
Alt+Q Complete a transfer.
Alt+Shift+Q Abort a transfer.
Control+Shift+A Initiate a blind conference.
Control+A Initiate a consult conference.
Alt+A Complete a conference.
Alt+Shift+A Abort a conference.
F8 Log in to skills.
F9 Log out of skills.
F10 Change to the AUX mode.
F11 Change to the ACW mode.
F12 Change to the Available mode.

Toolbars and menus
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Appendix B: Plug-ins

Rules Plug-in

About Rules Plug-in
The Rules Plug-in is a plug-in component that allows you to create a simple set of rules that
automatically perform actions on call events that meet certain criteria. This rule functionality is
similar to the email rules capability in Microsoft Outlook. Without changing an application's code,
you can use the Rules Plug-in to enhance desktop functionality. For example, you can configure
rules to:

• Deflect calls from a specific CLI to voicemail

• Open another application or website

• Send data and key strokes to another customer-related application

• Bring another window to the front to help process a call

• Pass data to another application that supports DDE

Essentially, a rule fits into a simple statement; when a certain event occurs and a call property
matches this value, do this action then either continue rules processing, jump to another rule or
stop.

The Rules Plug-in is started by the controlling application. The configuration data passed to it
consists of the mandatory generic plug-in configuration data and a list of rules to be processed.

The functionality to build valid rules that relate to a specific desktop product is managed by the
individual controlling application. The application uses the Rules Plug-in to execute those rules.

Call Center Elite Multichannel Desktop uses the Desktop Rules Plug-in to convert events into events
for the Rules Plug-in. Rules Plug-in also provides the Rules window that allows you to easily create,
change, and remove rules. These rules are stored as simple text strings in the Call Center Elite
Multichannel Desktop .ini file.
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Call Center Elite
Multichannel Desktop
Plug-in (Email Plug-in,

Preview Contact Plug-in)

Rules Window

Rules Plug-in

Events Return event
List of supported events

(Email, WIDelivered,
PCWIClosed)

ini file

Call Center Elite Multichannel Desktop

The Rules Plug-in and the Rules Wizard are installed as part of the Call Center Elite Multichannel
Desktop installation.

Error logging
Call Center Elite Multichannel plug-ins log error information relating to their operation into the error
log file of their controlling application.

For Call Routing Server log files, refer to the directory:<CCEM_INSTALL_DIR>\Avaya Aura CC
Elite Multichannel\Server\Call Routing Server\*ACRS.Log

Installing Rules Plug-in
Call Center Elite Multichannel plug-ins are not installed as separate components, but as part of the
installation for applications that support their integration. For more information on installing the
supporting applications, see Installing Avaya Aura® Call Center Elite Multichannel Guide.

In addition to the standard installation steps, this appendix explains:

• how you can use command line parameters during installation to dictate where configuration
information is retrieved.

• how you can change the configuration source from the local .ini file to the Configuration Server
if an application has already been installed.
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• how to automatically (silently) install an application following a set of pre-defined selection
options.

Configuration of Rules Plugin
Configurable parameters

The following are the list of parameters that can be configured for the Rules plugin.

Enable Client A value that determines if the controlling application will enable this plug-in on
startup. True=enabled, False=disabled.

Client Library
Name

The name of the generic plug-in: ASGRules.dll

Display Name The text that displays on the client's user interface.

Display Icon An icon that displays on the client's user interface to represent its running
process.

Event Type Indicates to the server loading the plug-in if it wishes to do maintenance tasks
or real work. Use Event Type=Native to tell the server that the plug-in wishes to
interface for native server functionality.

[Sections] field descriptions
The following data must appear as one section but can be repeated to create more sections. A
section will be used if the received event and filter values match the configured event and filter
values.

Name Description
Event Name The name of the event sent by the controlling

application that will invoke this configuration set.
When combined with the Event Filter Name and
Event Filter Value parameters, this represents a
unique combination. If filtering is not used (by the
Event Filter Name parameter being empty), the
Event Name parameter is expected to be unique. If
it is not, the first entry in the configuration sequence
is used.

Event Filter Name A name expected in the parameter list sent with the
event from the controlling application. This filter
allows multiple configuration sets to have the same
Event Name but be identified by a received
parameter value. If this parameter is empty, filtering
will not be used.

Table continues…

Rules Plug-in

July 2016 Avaya Aura® Call Center Elite Multichannel Desktop User Guide 101
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Aura® Call Center Elite Multichannel Desktop User Guide


Name Description
Event Filter Value The value the plug-in will try and match with the

received event and event filter. If there is a match,
this configuration set is deemed the correct
sequence. Example: With a configuration set of
Event Filter Name=VDN and Event Filter
Value=9830, any event received with a matching
Event Name must also contain, as part of the event's
parameter sequence, a set VDN/9830.

For more information on how to construct a rule, see Rules language on page 102.

Rules language
The following keywords are used to create rules:

• When

• LinkedRule

• And

• Always

• Do

• Nothing

• Then

• Continue

• GotoRule

• Stop

When and LinkedRule
Triggers are matched against events as they are received from the controlling application. This is a
simple string match on the event name received with the ASHandleServerEvent and the name that
follows the When keyword in the received rule. The event name consists of all text from the end of
the When keyword to the beginning of the And or Always keyword that follows.

This allows event names to consist of spaces and irregular characters.

The LinkedRule keyword is an exception to the event name matching. This keyword allows this rule
to be executed only when called from another rule. This allows the simple chaining of common rules
from different trigger sources.

Example
The following is an example for configuring rules:

Rule 1 = When ApplicationOpened Always Do Open Calc.exe

Rule 2 = When CallAlerting And CallerDN = 1234 Do BringToFront Calculator Then GotoRule 4
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Rule 3 = When CallAnswered And CallerDN = 1234 Do SendKeys Calculator, %CallerDN%
{ENTER} Then GotoRule 4

Rule 4 = When LinkedRule And CallerDN = 1234 Do DDEPoke MyService, MyTopic, MyItem,
%CallerDN%

Always, And, and Nothing clause
The And clause allows a piece of event data to be verified to help filter this rule from others. It
supports checking of any key/value received with the event parameters.

Assessment of the value of an event value is done using the keyword operators <,> and =. The
event key/values are compared to either a literal string value or the keyword Nothing. If a value that
is required to be matched by the rule does not exist in the received key/value set, this rule fails and
further rules are checked.

Value Description
CallerDN = 1234 Matches the key/value item CallerDN on a literal

value 1234.
CallerDigits > Nothing Checks that the key/value item contains some data,

that is, the key/value item is not an empty string.
CallerDigits = Nothing Checks that the key/value item is empty. Note: The

key/value must still be present in the received event
key/value list.

The Always keyword removes any filtering for this trigger. And is mutually exclusive with Always.

Examples:
Rule 1 = When ApplicationOpened Always Do Open Calc.exe

Rule 2 = When CallAlerting And CallerDN = 1234 Do BringToFront Calculator Then GotoRule 4

Note:
A rule supports multiple And clauses that can be chained to allow checking of a number of event
properties. For the rule to be selected, all And clauses must be successfully matched.

Do clause
The Do clause specifies the action (or actions) to be taken when the trigger and filter conditions are
satisfied.

Some of these actions require further values to satisfy the action requirements. These are termed
action values. As a standard, action values are a comma-separated list of string literals used to
perform the action. All action values are parsed to allow data from the call object to be inserted into
the action value.

Available actions are:

• Open

• SendKeys

• BringToFront
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• Clipboard

• WriteFile

• DDEPoke

• DDEExecute

• DDEServer

• ReturnEvent

• SocketClient

• SocketServer

• ASGExtension

• Nothing

• SQL

• Alert

Open clause
The Open action launches the specified program based on the current shell settings. The rule does
not wait for the program to exit. This action expects action values that contain the full path to the
executable and any command line parameters. Action values are passed to replace any dynamic
command line data with values from the current call object.

If the target is an executable file, then command line parameters must appear as a second comma-
separated action value.

Examples:
Open MissedCallLog.exe, %CallerDN% %CalledDN% %UUI%

Open http://SomeServer/ MissedCallLog&%CallerDN%+%CalledDN%+%UUI%

Note:
If you are using the action as a Windows Run command, the comma between the command
and parameters should not be entered. For example: MissedCallLog.exe %CallerDN%
%CalledDN% %UUI%

SendKeys
The SendKeys action sends keystrokes (CTI information) to applications that have no automation
interface. This action expects two action values to be configured with it.

The first is the name of the window to be activated. This action value supports a wildcard character
“*” , which allows applications that dynamically adjust the window title based on specific data (for
example, Agent) to be located and shown:
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Value Description
* at the end Matches any window with a title starting with the

specified text. For example: Active* will find the first
window starting with Active.

* at the begin Matches any window with a title ending with the
specified text. For example: *Notepad will find the
first window with a title ending in Notepad, for
example, Untitled - Notepad.

* at beginning and end Matches any window with a title containing the
specified text. For example: *Note* will find the first
window with a title containing Note, for example,
Untitled - Notepad.

The second action value is the sequence of key strokes to be sent once the window has been
located. This action value is passed to replace any dynamic command line data with values from the
current call object.

Example:
SendKeys *Notepad, %CallerDigits%

Most keyboard characters are represented by a single keystroke. To send a single keyboard
character, send the character itself as the string argument. For example, to send the letter x, send
the string argument “x”. To send a space, send the string “ ".

To send more than one keyboard character at a time, send a sequence of characters as a
compound string argument. For example, to send letters a, b, and c, send the string argument “abc”.

The SendKeys action uses the following characters as character modifiers (instead of using their
face-values):

Special character Argument
{ } Braces
( ) Parenthesis
[ ] Square brackets

Special character Argument Key
+ Plus sign SHIFT
^ Caret CTRL
% Percentage ALT
~ Tilde ENTER

Braces “{ }” are used to send non-character keystrokes and keystrokes that represent actions:

Key Argument
{ } Braces
( ) Parenthesis
[ ] Square brackets
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Key Argument
BACKSPACE {BACKSPACE}, {BS}, or {BKSP}
BREAK {BREAK}
CAPS LOCK {CAPSLOCK}
DEL or DELETE {DELETE} or {DEL}
DOWN ARROW {DOWN}
END {END}
ENTER {ENTER}
ESC {ESC}
HELP {HELP}
HOME {HOME}
INS or INSERT {INSERT} or {INS}
LEFT ARROW {LEFT}
NUM LOCK {NUMLOCK}
PAGE DOWN {PGDN}
PAGE UP {PGUP}
PRINT SCREEN {PRTSC}
RIGHT ARROW {RIGHT}
SCROLL LOCK {SCROLLLOCK}
TAB {TAB}
UP ARROW {UP}
FI {F1}
F2 {F2}
F3 {F3}
F4 {F4}
F5 {F5}
F6 {F6}
F7 {F7}
F8 {F8}
F9 {F9}
F10 {F10}
F11 {F11}
F12 {F12}
F13 {F13}
F14 {F14}
F15 {F15}

Table continues…
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Key Argument
F16 {F16}
F17 {F17}
F18 {F18}
F19 {F19}
F20 {F20}
F21 {F21}
F22 {F22}
F23 {F23}
F24 {F24}
NUMPAD0 {NUMPAD0}
NUMPAD1 {NUMPAD1}
NUMPAD2 {NUMPAD2}
NUMPAD3 {NUMPAD3}
NUMPAD4 {NUMPAD4}
NUMPAD5 {NUMPAD5}
NUMPAD6 {NUMPAD6}
NUMPAD7 {NUMPAD7}
NUMPAD8 {NUMPAD8}
NUMPAD9 {NUMPAD9}
NUMPADMULTIPLY {NUMPADMULTIPLY}
NUMPAD* {NUMPAD*}
NUMPADADD {NUMPADADD}
NUMPAD+ {NUMPAD+}
NUMPADSUBTRACT {NUMPADSUBTRACT}
NUMPAD- {NUMPAD-}
NUMPADDECIMAL {NUMPADDECIMAL}
NUMPAD/ {NUMPAD/}
LEFTBRACE {LEFTBRACE}
RIGHTBRACE {RIGHTBRACE}

Square brackets “[ ]” have no special meaning when used with SendKeys, but you must enclose
them within braces to accommodate applications that do give them a special meaning (dynamic
data exchange (DDE) for example).

The plus sign “+” , precedes a character to specify the SHIFT key is held down while the character
is pressed. For example, to specify the SHIFT key is held down while e is pressed, send the string
argument “+e”.
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Note:
When used this way, these special characters are not enclosed in braces.

The caret “^” precedes a character to specify the CTRL key is held down while the character is
pressed.

The percentage symbol “%” precedes a character to specify the ALT key is held down while the
character is pressed.

A combination of SHIFT, CTRL and ALT can be used at once. For example, to specify the SHIFT
and CTRL keys are held down while e is pressed, send the string argument “+^e”.

Parentheses “( )” are used when you want SHIFT, CTRL or ALT held down while several keys are
pressed. For example, to specify the SHIFT key is held down while e and c are pressed, send the
string argument “+(ec)”.

Note:
If you leave out the parentheses “+ec”, you are specifying the SHIFT key is held down while e is
pressed but not when c is pressed.

The tilde character “~” can be used as an alternative to the argument {ENTER} to press the ENTER
key.

To send +, ^, & or ~, enclose the special character in braces “{ }”. For example, to send the plus
sign, send the string argument “{+}”.

To send brace characters, send the string argument “{LEFTBRACE}” for the left brace and
“{RIGHTBRACE}” for the right one.

BringToFront
The BringToFront action attempts to find the named window and bring it to the front. If the window
cannot be found, this action fails immediately. This action expects two action values to be
configured with it.

Syntax
BringToFront Window Name, Show Style

Window
Name

The name of the window to be activated. This action value supports a wildcard
character “*”, which allows applications that dynamically adjust the window title
based on specific data (for example, Agent) to be located and shown in the
following table:

Value Description
* at the end Matches any window with a title starting with the

specified text.

For example: Active* will find the first window starting
with Active.

* at the begin Matches any window with a title ending with the
specified text.

Table continues…
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Value Description
For example: *Notepad will find the first window with
a title ending in Notepad, for example, Untitled -
Notepad.

* at beginning and end Matches any window with a title containing the
specified text.

For example: *Note* will find the first window with a
title containing Note, for example, Untitled - Notepad.

Show
Style

The size of the window when it is brought to the front. Options are:
• NORMAL. The window displays at its default (partial screen) size.
• MAXIMIZED. The window is maximized so it covers the full screen.
• RESTORE. The window is restored to its previous size (the size it was before it was

last minimized or maximized).

Note:
NORMAL, MAXIMIZED and RESTORE must appear in capitals to work.

Example:
BringToFront Calculator, NORMAL

Clipboard
The Clipboard action places data into the clipboard in the specified format. This data can then be
used by other applications that support clipboard access.

Syntax
Clipboard Data

Data The format of the data that will be inserted into the clipboard when the event occurs. This
parameter can be modified by event properties.

Example
Rule1 = When CallAlerting Always Do Clipboard %CallerDN% Then Stop

In this example, when a CallAlerting event is received by the Rules Plug-in, the CallerDN event
property is placed in the system clipboard. The user will then be able to use the paste function to
insert the data to another application.

This function will replace the current contents of the clipboard.

WriteFile
The WriteFile action opens the specified file and writes data into it in the specified format.

Syntax
WriteFile File Name, OpenType, Data
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OpenType Determines how the file will be opened. Valid types are APPEND (data will be added
to the end of the existing file or a new file will be created), and CREATE (a new
empty file will be created and the formatted data will be written to it).

File Name The name of the file to be opened.

Data The format of the data that will be inserted into the file when the event occurs. This
parameter can be modified by event properties.

Example
Rule1 = When CallAlerting Always Do WriteFile c:\temp\out.txt, APPEND, %CallerDN% Then Stop

In this example, the CallAlerting event causes the Rules Plug-in to open the file c:\temp\out.txt
and appends the contents of the CallerDN event property to it. If the file is not found, the Rules Plug-
in attempts to create it.

DDEPoke
The DDEPoke action opens a Dynamic Data Exchange (DDE) connection to another application
using a service name, topic and item as action values. Data in the format specified in the final action
value will be “poked” into the application and the connection will be closed. This parameter will be
modified using data received with the trigger event. These values can be a mixture of literals, that is
Destination = 8888 or values taken from the received event. Values to be copied from the received
event are enclosed in the % character.

A service name is an application that can participate in a DDE conversation. Usually, the application
is the name of an .exe file (without the .exe extension) for a Microsoft Windows-based application,
such as Microsoft Excel.

A topic is the name of a topic recognized by the application. The topic is often a document or data
file.

An item is the name of a data item recognized by the application.

Example
The following example puts the calling party number into the first cell of Sheet1 in an Excel
spreadsheet:
DDEPoke Excel,Sheet1,R1C1,%CallerDN%

The following is a complete rule from an ActiveAgent.ini file:
Rule1=When CallAlerting Always Do DDEPoke Excel,Sheet1,R1C1,%CallerDN% Then Continue

DDEExecute
The DDEEXECUTE action opens a Dynamic Data Exchange (DDE) connection to another application
using a service name, topic and item as action values. Data in the third action value parameter
indicates the command to be executed. This parameter will be modified using data received with the
trigger event. These values can be a mixture of literals, that is Destination = 8888 or values taken
from the received event. Values to be copied from the received event are enclosed in the %
character.
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A service name is an application that can participate in a DDE conversation. Usually, the application
is the name of an .exe file (without the .exe extension) for a Microsoft Windows-based application,
such as Microsoft Excel.

A topic is the name of a topic recognized by the application. The topic is often a document or data
file.

An item is the name of a data item recognized by the application.

Example
This example opens the form called form1 in an Microsoft Access database called DB1.
DDEExecute MSAccess,DB1,,[OpenForm form1] 

DDEServer
The DDEServer action instructs the Rules Plug-in to setup as a DDE server and accept incoming
connections from other applications that support DDE.

Registration of the DDE Service, Topic and Item is done by the Rules Plug-in at startup.
Connections are then accepted at any time.

Client applications that connect to the Rules Plug-in using this mechanism can also send data that
can be used to interact with the Rules Plug-in or the controlling application. For more information,
see Returned Data from Client.

Syntax
DDEServer Service, Topic, Item, Data

Service The name of the DDE service that the Rules Plug-in will register with the Windows
system.

Topic The name of the DDE topic that the Rules Plug-in will register with the Windows system.

Item The name of the DDE item that the Rules Plug-in will register with the Windows system.

Data The format of the data that will be passed to all connected clients when the event
occurs. This parameter can be modified by event properties.

Example
In this example, when the CallAlerting event is received, any connections that are currently active
with the specified Service, Topic and Item will receive data that is comprised of the CallerDN
property.
Rule1 = When CallAlerting Always DO DDEServer CCEMService, CCEMTopic, CCEMItem, %CallerDN
% Then Stop

ReturnEvent
The ReturnEvent action returns an event to the controlling application. The action requires at least
one action value which represents the name of the event to be called. The action can also take a list
of comma-separated values after the event name that will represent the values to be returned with
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the event. These values can be a mixture of literals, that is Destination = 8888 or values taken from
the received event. Values to be copied from the received event are enclosed in the % character.

Example
ReturnEvent Deflect, %CallAppearance%,Destination = 8888
iTable.Commit

SocketClient
The SocketClient action causes the Rules Plug-in to open a socket-based connection to the
specified IP address on a specified port and send some dynamic data. The socket connection
closes once the data is transferred.

Example
SocketClient 192.168.0.10, 80, %CallerDigits%\n

SocketServer
The SocketServer action instructs the Rules Plug-in to listen on a specific IP port and accept
incoming connections from other applications.

The setup to accept incoming connections from other applications is performed when the Rules
Plug-in starts. New connections are accepted at any time. When the triggering event occurs, any
connections that are currently available will receive the specified data.

Client applications that connect to the Rules Plug-in using this mechanism can also send data that
can be used to interact with the Rules Plug-in or the controlling application. For more information,
see Returned Data from Client.

Syntax
SocketServer IP Address, IP Port, Data

IP Address The IP address that will be used to accept incoming connections on. If this
parameter is 0, the Rules Plug-in will listen on all available IP addresses in the
machine.

IP Port The IP port that will be used to accept incoming connections.

Data The format of the data that will be passed to all connected clients when the event
occurs. This parameter can be modified by event properties.

Example
In this example, incoming connections are accepted on the IP address 192.168.10.101 at port
29090. When a CallAlerting event is received by the Rules Plug-in, the CallerDN event property will
be sent to every client that has connected.
Rule1 = When CallAlerting Always Do SocketServer 192.168.10.101, 29090, %CallerDN% Then 
Stop
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ASGExtension
The ASGExtension action causes the Rules Plug-in to load another generic plug-in and make it
available for sending events. This action expects a minimum of two action values. The first action
value specifies the name of the plug-in to be loaded. This name should be a full path, if required.
The second action value is the name of the event to be called when this action is to be executed.
Following the two required action values is a list of key value pairs that are sent to the loaded
generic plug-in either at load time, when the event is called or both.

Syntax
Start:Client Enabled = True

Start Key value pairs to be sent when the generic plug-in is loaded will have the key value
prefixed with the word Start:. The Start: delimiter is removed from the key name before
being sent with startup data.

Event:CallerDN = %CallerDN%

Event Key value pairs that are to be sent to the generic plug-in with the associated event will be
prefixed with the word Event: The Event: delimiter will be removed from the key name
before being sent with the event.

Example 1
In this example, the key Client Enabled would be sent with startup data. It would have a value of
true.
Start:Client Enabled = True

Example 2
In this example, the key CallerDN would be sent with the event to the loaded generic plug-in. It
would have a value taken from the key value CallerDN received with the incoming event to the ASG
Rules engine.
Event:CallerDN = %CallerDN%

Example 3
In this example the Rules Plug-in loads the additional plug-in ASGSendMail. When this plug-in is
loaded, Rules Plug-in sends a single key value of Client Enabled with a value of True. When the
action is run, the Rules Plug-in sends an event of ASSendMail to the loaded plug-in with the key
values prefixed with the word Event.
ASGExtension ASGSendMail.dll, ASSendMail, Start:ClientEnabled = True,
Event:ASMailServer = agile01, Event:ASMailSenderAddress = matthew.bagley@abc.com,
Event:ASMailRecipientAddress = matthew.bagley@abc.com, Event:ASMailSubject = Call
from %CallerDN% diverted

Nothing
The Nothing action allows you to channel multiple rules into a single rule. It can also be used to
introduce a time delay before the next rule is executed. The time delay parameter is expressed in
milliseconds.
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Example
The following example shows two rules (1 and 2) that are triggered by different event names,
funneling into a single rule, rule 3, which holds TCP/IP socket connections from other applications.
When rule 3 is activated, it sends data in the format specified.
Rule1 = When CallAlerting Always Do Nothing 1000 Then GotoRule 3
Rule2 = When CallCleared Always Do Nothing Then GotoRule 3
Rule3 = When LinkedRule Always Do SocketServer 192.168.10.6, 12345, %EVENTNAME% has fired

SQL
The SQL action allows a simple SQL statement to be executed. The Rules Plug-in requires Microsoft
ADO to be installed and uses this technology to open the database and executes the SQL
statement.

Syntax
SQL Connection String, SQL Statement

Connection String The string used by ADO to connect to, and open, the database.

SQL Statement The SQL statement to be executed against the specified database. This
parameter can be modified by event properties.

Example
This example opens a Microsoft Access database called ASGRulesTest.mdb using the specified
connection string and inserts details about the call into a table labeled tblCallEvents.
Rule1 = When CallAlerting Always Do SQL DRIVER=={Microsoft Access Driver(*.mdb)};DBQ=C:
\ASGRules\SampleApplications\Database\ASGRulesTest.mdb;Uid=Admin;Pwd=; , Insert Into 
tblCallEvents (Event, UCID, CallerDN, CalledDN) Values('%EVENTNAME%', '%UCID%', '%CallerDN
%', '%CalledDN%')

Notify
The Notify action notifies the user with text in a taskbar window that auto hides. The Notify popup
should follow the location of the taskbar (top, left, right and bottom).

Note:

To display the non-English text in the Notify window, you must correctly set the collation in the
SQL database for the language in which you have installed Call Center Elite Multichannel.

Syntax
Notify Notify Text, Show Speed, Keep Alive Time

Notify
Text

The text you want to display to the user. If the Show Speed and Keep Alive Time
parameters are missing (that is Notify Notify Text), the default behavior is for the text to
take 3 seconds to appear (fade in), sit static on the screen for 3 seconds, and then take
3 seconds to disappear (fade out).
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Note:
You can insert a line break in the Notify Text by typing ‘0x0A’. You can also display
call-related information in your Notify Text by specifying event properties
(%property%).

To add other ASCII characters such as comma, space, and tab, you must insert
the corresponding Hex code mentioned in the standard ASCII chart.

Show
Speed

The number of seconds it takes for the text to appear. Also the number of seconds it
takes for the text to disappear. For example, if you specified 5, it would take 5 seconds
for the text to appear and another 5 seconds for the text to disappear. The value must
be between 0 and 10. This parameter is optional. If missing (that is Notify Notify Text,
Keep Alive Time), the text will appear and disappear straight away with no fading in/
fading out time.

Keep
Alive
Time

The number of seconds the text is static on the screen before it begins to disappear.
The value must be between 1 and 100. This parameter is optional. If missing (that is
Notify Notify Text, Show Speed), the default behavior will be used (that is the text will
remain static on the screen for 3 seconds.) If you type an extra comma to indicate
where the value would be (that is Notify Text, Show Speed, ,) the value is assumed to
be 0 and the text will start to disappear as soon as it has appeared.

Example
The following example statically displays the text 'Incoming Call' for 10 seconds. It takes the text 2
seconds to fade in and 2 seconds to fade out.
When CallAlerting Do Notify Incoming Call, 2, 10

The following example statically displays the caller's station DN for 10 seconds. The text spends no
time fading in and out.
When CallAlerting Do Notify %CallerDN%, ,10

The following example statically displays the caller's station DN for 3 seconds. It takes the text 2
seconds to fade in and 2 seconds to fade out.
When CallAlerting Do Notify The caller is %CallerDN% 0x0A %CallerDigits%, 2

Alert
The Alert action brings a message box dialog to the front of the user application which alerts the
user to a piece of information. This dialog has an OK button which the user is required to click
before processing can continue.

Syntax
Alert Caption, Message

Caption The caption of the alerting message box

Message The message that will be displayed to the user when the event occurs.
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Example
In this example, the Rules Plug-in displays a message box to the user with a caption of 'Alert From
Rules Engine' and a message body that contains the CallerDN event property.
Rule1 = When CallAlerting Always Do Alert "Alert From Rules Engine", %CallerDN% Then Stop

Default Event Parameters
All events come to the Rules Plug-in with event properties governed by the calling application.
However, the Rules Plug-in will automatically make available to the rule certain system parameters
that will aid in rule development. These system parameters will be referenced by a keyword which
must be enclosed in % marks like other event properties (for example, %HOSTNAME%)

Syntax

LOGGEDINUSERNAME This property inserts the name of the user currently logged into the
computer running the host application.

HOSTNAME This property inserts the name of the machine the Rules Plug-in is
currently running on.

IPADDRESS This property inserts the IP address of the machine the Rules Plug-in
is currently running on.

EVENTNAME This property inserts the name of the event that triggered the Rules
Plug-in to run. This event name will be as received from the host
application and will not be modified if rules are linked together.

ENVIRONMENT This property allows the Rules Plug-in to pick up a variable from the
current system environment and place it into the formatted data string.
The name of the environment variable will be separated from the
keyword by a colon.

Example
This example will retrieve the environment variable PATH and present this to the user in a simple
message box.
Rule1 = When CallAlerting Always Do Alert Path, %ENVIRONMENT:PATH%

Returned Data from Client
The SocketClient, SocketServer and DDEServer types of connectivity allow client applications to
pass information to the Rules Plug-in that will be passed to the controlling application via the ASG
interface. This return data must be text, it must be terminated with a single carriage return character
and must contain key/value pairs in the format key=value. Multiple key/value pairs must be
separated by a single comma. The data received must contain at least one key/value pair that
indicates the name of the event to fire via the ASG interface. This must have a key name of 'Event'.

Example
If a connected client sent a piece of formatted text 'Event=CallDial,Number=8888' to the Rules Plug-
in, the Rules Plug-in would send an event to the controlling application with the event name being
CallDial and a single event parameter with a key of Number and a value of 8888. If the receiving
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application happened to be Agent from Avaya Aura® Call Center Elite Multichannel, this would
cause Agent to go off-hook and dial the number 8888.

Then, Continue, GotoRule, and Stop
The Then clause is optional at the end of the rule and allows the rule designer to specify what
happens after this rule has been selected and executed. If the Then clause is not specified, rules
processing terminates.

One of three keywords will follow the Then clause keyword, specifying the post rules action to take:

• The Continue clause indicates that further rules processing should occur. Rules that appear
after this rule will be assessed to determine whether they match the When/And criteria. If they
do they will be executed.

• The GoToRule clause allows this rule to jump to another rule. The rule specified is executed
provided it matches the When/And criteria. The GotoRule keyword expects the rule number
to be provided as an additional parameter.

• The Stop clause stops rules processing.

Example
Rule 2 = When CallAlerting And CallerDN = 1234 Do BringToFront Calculator Then GotoRule 4

Sample Configuration for Call Routing Server
This sample demonstrates how you can use Call Routing Server with the Rules Plug-in to route
incoming calls to the particular agent based on caller-entered digits.

Upon receiving an event from the Telephony Server, the Call Routing Server searches each section
of its configuration, attempting to match the received information with the Event Name, Filter Name
and Filter Value values. If the server does not make a match with one section, it moves to the next.

The Call Routing Server would stop at the following section if it receives a RouteRequest event from
VDN 9885*.

Once the match is made, the server passes the event to the Rules Plug-in, which executes the
configured rule(s).

In this case, the first rule will run if the received event is RouteRequest and it carries digits collected
with the call (user-entered code). If these rule requirements are met, the plug-in will return a
RouteSelect event to the Call Routing Server, instructing it to route the call to the extension entered
by the user and to display that extension number to the agent as user-to-user information (UUI). It
will also return the received RouteRegisterReqID and RoutingCrossRefID parameters to identify the
route request.

If the requirements of the first rule aren't met (in this case there are no collected digits with the call),
the second rule will be used and the RouteSelect event will request the call be routed to extension
8888.

On receiving the RouteSelect event, the Call Routing Server will pass it to the Avaya Telephony
Server, which will in turn, pass it to the Avaya Communication Manager for routing to the agent.

* VDN 9885 must be registered as a routing VDN before Call Routing Server can receive
RouteRequest events from it (see the Call Routing Server parameter Routing VDN List).
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Note:

It is essential that event parameters are typed accurately, with uppercase letters in the right
place and without spaces between words.

• Enable Client=True

• Client Library Name=ASGRules.dll

• Display Name=Rules Engine

• Display Icon=someicon.ico

• Event Type=Native

First Section:

• Event Name=RouteRequest

• Event Filter Name=VDN

• Event Filter Value=9885

Example
Rule1=When RouteRequest And UserEnteredCode>Nothing Do ReturnEvent RouteSelect , 
%RouteRegisterReqID%, %RoutingCrossRefID%, RouteSelected=%UserEnteredCode%, UUI=
%UserEnteredCode% Then Stop
Rule2=When RouteRequest Always Do ReturnEvent RouteSelect , %RouteRegisterReqID%,
%RoutingCrossRefID%, RouteSelected=8888

External browser application
To open URLs in full screen mode, Call Center Elite Multichannel Desktop provides an external
browser application named IEBrowserWindow.exe. This application opens URLs using Microsoft
Internet Explorer Browser Control to support the kiosk mode functionality of Internet Explorer. Call
Center Elite Multichannel Desktop can use this application only when you create rules through
Rules Plug-in.

Example
• Rule1 = When Voice.WIDelivered Always Do ReturnEvent 
Container.LaunchNewExternalApplicationWindow,externalAppConfigSectionName=External 
Application 2,externalAppCommandLine=-URL="http://<URL 
name>",callIDToCloseWindowWhenCallDropped=%CallID% Then Continue Else Stop

Use this rule to open the URL when a voice work item is delivered with menu bar, toolbar, and
status bar enabled and URL opened in full screen mode.

• Rule1 = When Voice.WIDelivered Always Do ReturnEvent 
Container.LaunchNewExternalApplicationWindow,externalAppConfigSectionName=External 
Application 2,externalAppCommandLine=-URL="http://<URL name>"  -toolbar=1 -
statusbar=0 -menubar=0,callIDToCloseWindowWhenCallDropped=%CallID% Then Continue 
Else Stop

Use this rule to open the URL when a voice work item is delivered with toolbar enabled and
status bar and menu bar disabled.

• Rule1 = When Voice.WIDelivered Always Do ReturnEvent 
Container.LaunchNewExternalApplicationWindow,externalAppConfigSectionName=External 
Application 2,externalAppCommandLine=-URL="http://<URL name>"  -toolbar=0 -
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statusbar=1 -menubar=0,callIDToCloseWindowWhenCallDropped=%CallID% Then Continue 
Else Stop

Use this rule to open the URL when a voice work item is delivered with status bar enabled and
toolbar and menu bar disabled.

• Rule1 = When Voice.WIDelivered Always Do ReturnEvent 
Container.LaunchNewExternalApplicationWindow,externalAppConfigSectionName=External 
Application 2,externalAppCommandLine=-URL="http://<URL name>"  -toolbar=1 -
statusbar=0 -menubar=1,callIDToCloseWindowWhenCallDropped=%CallID% Then Continue 
Else Stop

Use this rule to open the URL when a voice work item is delivered with status bar disabled and
toolbar and menu bar enabled.

Note:
To enable the menu bar, toolbar must be enabled.

Rules Engine
Supported Events

Rules.Started
This event is triggered by the Rules Engine to indicate that Rules functionality has been initialized
and other events may be received. This event is guaranteed to be the first event sent to the Rules
Engine.

Supported parameters:

None.

Rules.Stopped
This event is fired to indicate that Rules functionality has stopped and no further events will be
received. This indicates (primarily) that the host application is being closed. This event is
guaranteed to be the last event sent to the Rules Engine.

Note:
It is assumed that this event is sent as a result of the Rules Plug-in being stopped. Since the
Rules Engine (ASG Rules) processes events on a different thread to the containing plug-in, a
finite period of time (5 seconds) must be given for this rule to execute before the plug-in honors
the request to shut down.

Supported parameters:

None.

Supported Return Events
Rules.ActiveWindow

The event activates the named window within Call Center Elite Multichannel Desktop.

Supported parameters:
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WindowTitle The name of the window that is activated. This supports the following matching
capabilities:
• Starts with (for example, Def*)
• Ends with (for example, *ity)
• Contains (for example, *ef*), and
• Exact (for example, Definity)

Example:

This example activates the window whose title starts with 'Definity' when a voice delivered event
occurs.
When Voice.WIDelivered Always Do ReturnEvent Rules.ActivateWindow, WindowTitle =Definity*

Telephony Plug-in

Supported Events
Voice.WIDelivered

Telephony Plug-in fires this event when a new voice work item is received at the desktop.

Supported parameters:
• CallerDN
• CalledDN
• UUI
• UserEnteredCode
• InteractionID
• ConversationID
• CustomerID
• UCID
• CallID
• VDN
• SplitSkill
• AgentID
• StationDN
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Voice.WIEstablished
Telephony Plug-in fires this event when a voice work item has been established at the desktop.

Supported parameters:
• CallerDN
• CalledDN
• CallID
• UCID
• UUI
• UserEnteredCode
• AgentID
• StationDN

Voice.WICleared
Telephony Plug-in fires this event when a voice work item has been cleared from the desktop.

Supported parameters:
• CallerDN
• CalledDN
• UUI
• CallID
• UCID

Supported Return Events
Voice.SendDTMF

This return event instructs Voice Plug-in to send DTMF tones on the specified call. If the call does
not exist, the mandatory parameters are not received, or the call is not in the correct state, then this
request is ignored.

Supported parameters:
• CallID (mandatory)
• DTMFTones (mandatory)

Voice.Dial
This return event is received instructs Voice Plug-in to create a new call attempt with the parameters
provided. If the mandatory parameters are not received, this request is ignored.

Supported parameters:
• Number (mandatory)
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• UUI (optional)

User Plug-in

Supported Events
User.AgentLogin

User Plug-in triggers this event when an agent successfully logs into the Avaya Communication
Manager.

Supported parameters:
• AgentID
• StationDN
• WorkMode

User.AgentLogout
User Plug-in triggers this event when an agent successfully logs out from the Avaya Communication
Manager.

Supported parameters:
• AgentID
• StationDN
• ReasonCode

User.AgentStateChange
User Plug-in fires this event when an agent successfully changes their agent state in the
Communication Manager.

Supported parameters:
• AgentID
• StationDN
• AgentState
• ReasonCode
• WorkMode
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Email Plug-in

Supported Events
Email.WIDelivered

Description
Email Plug-in fires this event when a new email work item is received at the desktop.

Supported parameters
• InteractionID
• ConversationID
• CustomerID
• MSQueueID
• From
• To
• Subject
• AgentID
• StationDN

Email.WIClosed
Description
Email Plug-in fires this event when an email work item is removed from the desktop.

Supported parameters
• InteractionID
• ConversationID
• CustomerID
• CompletionCode

Supported Return Events
None at this time.
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Wallboard Plug-in

Supported Events
Wallboard.FlashDisplayMessageAdded

Description
This event will be fired into rules as a result of another plug-in calling the AddFlashDisplayMessage
method.

This event will not fire when rules adds a message to the Wallboard.

Supported parameters
• Message
• DisplayTime
• MessagePriority
• MessageKey

Wallboard.StandardDisplayMessageAdded
Description
This event will be triggered into rules as a result of another plug-in calling the
AddStandardDisplayMessage method.

This event will not trigger when rules add a message to the Wallboard.

Supported parameters
• Message
• DisplayTime
• MessageKey

Wallboard.AlertTriggered
Description
This event will be fired into rules when an alert (threshold), that has been setup in the UI, is
triggered.

supported parameters
• AlertName – this is the name setup in the UI that identifies the triggering alert.
• AlertingDevice – the device identifier that has caused this alert to be triggered.
• AlertingDeviceName – the name associated with the device currently alerting.
• AlertingDeviceType – this is a string enumeration that can only contain the currently

administrable types. This must be one of "agent", "vdn" or "queue".
• ThresholdObject – the name of the parameter in that has currently exceeded its threshold.
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• CurrentValue – the value that this object currently has.

Wallboard.AlertReset
Description
This event is fired when an alert (threshold) that has previously been triggered has been reset.

Supported parameters
• AlertName – this is the name setup in the UI that identifies the triggering alert.
• AlertingDevice – the device identifier that has caused this alert to be triggered.
• AlertingDeviceName – the name associated with the device currently alerting.
• AlertingDeviceType – this is a string enumeration that can only contain the currently

administrable types. This must be one of "agent", "vdn" or "queue".
• ThresholdObject – the name of the parameter in that has currently exceeded its threshold.
• CurrentValue – the value that this object currently has.

Supported Return Events
Wallboard.AddFlashDisplayMessage

Description
This Rules return event will allow the Rules engine to add a flash display message to the Wallboard.
When this return event is caught by the Wallboard Plug-in, its behavior will be identical to a plug-in
calling the AddFlashDisplayMessage on the IWallBoard interface. The Wallboard Plug-in will need
to add in the optional parameters if they are not present.

Supported parameters
• Message – Required.
• DisplayTime – Required
• MessagePriority – Required
• MarqueeStyle – optional. Defaults to the general UI settings.
• Forecolour – optional. Defaults to the general UI settings.
• Backcolour – optional. Defaults to the general UI settings.
• PreferredMessageKey – optional. Allows the rules to specify the key for later message

removal. If missing, the Wallboard will assign its own unique key that will not be known to rules.

Wallboard.AddStandardDisplayMessage
Description
This Rules return event will allow the Rules engine to add a standard display message to the
Wallboard. When this return event is caught by the Wallboard plug-in, its behavior will be identical to
a plug-in calling the AddDisplayMessage on the IWallBoard interface.
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Supported parameters
• Message – Required.
• DisplayTime – Required
• PreferredMessageKey – optional. Allows the rules to specify the key for later message

removal. If missing, the Wallboard will assign its own unique key that will not be known to rules.

Wallboard.RemoveDisplayMessage
Description
This Rules return event will allow the Rules engine to remove a displayed message.

Supported parameters
• MessageKey – required. Identifies the message to be removed.

Preview Contact Plug-in

Supported Events
PC.WIDelivered

Description
Preview Contact Plug-in fires this event when a new preview contact work item is received to the
desktop.

Supported parameters
• InteractionID
• ConversationID
• CustomerID
• MSQueueID
• ProgramID
• AgentID
• StattionDN
• WorkItem Type

PC.WIClosed
Description
Preview Contact Plug-in fires this event when the preview contact work item is removed from the
desktop.
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Supported parameters
• InteractionID
• ConversationID
• CustomerID
• CompletionCode

Supported Return Events
None at this time.

Simple Messaging Plug-in

Supported Events
SMMS.WIDelivered

Description
Simple Messaging Plug-in fires this event when a new simple messaging work item is received at
the desktop.

Supported parameters
• InteractionID
• ConversationID
• CustomerID
• MSQueueID
• AgentID
• StationDN

SMMS.WIMessageReceived
Description
Simple Messaging Plug-in fires this event when a new simple message is received that is part of an
established interaction.

Supported parameters
• InteractionID
• ConversationID
• CustomerID
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• Message

SMMS.WIMessageSent
Description
Simple Messaging Plug-in fires this event when a new simple message is sent to the customer from
an established interaction.

Supported parameters
• InteractionID
• ConversationID
• CustomerID
• Message

SMMS.WIClosed
Description
Simple Messaging Plug-in fires this event when the simple messaging work item is removed from
the desktop.

Supported parameters
• InteractionID
• ConversationID
• CustomerID
• CompletionCode

Supported Return Events
None at this time.

External Application Container Plug-in

Supported Events
Container.SetExternalApplicationWindowActive

Description
This return event activates an existing window.

Supported parameters
• externalAppConfigSectionName. The configuration section name of the external application

that will be started or activated within the Call Center Elite Multichannel Desktop interface.
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Container.LaunchNewExternalApplicationWindow
Description
This return event starts a new window dynamically.

Supported parameters
• externalAppConfigSectionName. The configuration section name of the external application

that will be started or activated within the Call Center Elite Multichannel Desktop interface.
• externalAppCommandLine. The command line Call Center Elite Multichannel Desktop will use

to start the external application. It will override the default setting in the configuration file. If this
value is left blank, the original External Application Command Line configuration setting will be
used to start the application.

• callIDToCloseWindowWhenCallDropped. The CallID which will be used to close the window
that contains the external application when the specified call is dropped. If this value is blank,
the new window will not close when the call is dropped.

Example
Rule1 = When Voice.WIDelivered Always Do ReturnEvent 
Container.LaunchNewExternalApplicationWindow,externalAppConfigSectionName=External 
Application 2, externalAppCommandLine=support.avaya.com, 
callIDToCloseWindowWhenCallDropped=%CallID% Then Continue 

Microsoft Dynamics CRM Plug-in

Supported Events
MSCRM.CreateCompleted

Description
Microsoft Dynamics CRM Plug-in fires this event to the Call Center Elite Multichannel Desktop Rules
Plug-in when MSCRM.Create is completed.

Syntax
When MSCRM.CreateCompleted And invokeId=Rule1 Do ReturnEvent MSCRM.Screenpop, entity=
%entity%, id=%id%,bringToFront=true Then Continue 

Supported parameters

entity Microsoft Dynamics CRM entity that has been created.

ID The id of the entity instance which has been created.

invokeID This invoke id is provided for additional filtering if required, incase rules start to get
complicated and overlap each other. MSCRM Rules Return Event MSCRM.Create
includes this parameter.
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MSCRM.LookupCompleted
Description
Microsoft Dynamics CRM Plug-in fires this event to the Call Center Elite Multichannel Desktop Rules
Plug-in when MSCRM.Lookup is completed.

Syntax
When MSCRM.LookupCompleted And invokeId=Rule1 Do ReturnEvent MSCRM.Screenpop, entity=
%entity%, id=%id%,bringToFront=true Then Continue 

Supported parameters

entity Lookup has been completed on this MSCRM entity.

ID Unique identifier (GUID) of the resulting entity.

When no match is found, blank is returned. When multiple matches are found, a
pipe delimited list is returned.

1F8B6FC0-426A-4122-BAC2-A05B6071FC57|
DFE86B44-26E2-4c4e-90C5-63DEC7603927

Note:
If returnMultiples of return event MSCRM.Lookup was set to false (disabled),
only one id will be returned even if multiple matches were found. This is to
cater for external applications which cannot understand pipe delimited string
of ids.

invokeID This invoke id is provided for additional filtering if required, incase rules start to get
complicated and overlap each other. MSCRM Rules Return Event
MSCRM.Lookup includes this parameter. Initially this parameter is limited to use in
a static manner. Dynamically incrementing and associating the InvokeID may be
desirable in future releases if required.

matchCount Count of the number of matches. e.g. 0 or 1 or 2 etc.

MSCRM.RetrieveCompleted
Description
Microsoft Dynamics CRM Plug-in fires this event to the Call Center Elite Multichannel Desktop Rules
Plug-in when MSCRM.Retrieve is completed.

All attributes (including custom attributes) of the retrieved Microsoft Dynamics CRM entity instance
are returned and made available.

Syntax
When MSCRM.RetrieveCompleted And invokeId=Rule1 

Supported parameters

entity Retrieve has been completed on this Microsoft Dynamics CRM entity.
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invokeID This invoke id is provided for additional filtering if required, incase rules start to
get complicated and overlap each other. Microsoft Dynamics CRM Rules Return
Event MSCRM.Retrieve includes this parameter.

Initially this parameter is limited to use in a static manner. Dynamically
incrementing and associating the InvokeId may be desirable in future releases if
required.

All attributes
of the
retrieved
entity

The number of attributes will be different for each Microsoft Dynamics CRM
entity.

MSCRM.RetrieveCompleted Return Event will return all attributes including
custom attributes of the retrieved entity instance.

MSCRM.Appointment.ActivityDelivered
Description
Microsoft Dynamics CRM Plug-in fires this event to Call Center Elite Multichannel Desktop Rules
Plug-in when a Microsoft Dynamics CRM appointment activity is delivered to Call Center Elite
Multichannel Desktop.

All attributes (including custom attributes) of the Microsoft Dynamics CRM appointment activity are
returned and made available.

Syntax
When MSCRM.Appointment.ActivityDelivered 

Supported parameters

All attributes of the Microsoft
Dynamics CRM appointment activity
(including custom attributes).

The number of attributes can be different based on the
customization of your Microsoft Dynamics CRM
implementation.

Note:
For a full list of attributes for each entity, see the Microsoft Dynamics CRM Entity reference
available at http://YourMSCRMServer/sdk/list.aspx.

MSCRM.CampaignActivity.ActivityDelivered
Description
Microsoft Dynamics CRM Plug-in fires this event to the Call Center Elite Multichannel Desktop Rules
Plug-in when a Microsoft Dynamics CRM campaign activity is delivered to the desktop.

All attributes (including custom attributes) of the Microsoft Dynamics CRM campaign activity are
returned and made available.

Syntax
When MSCRM.CampaignActivity.ActivityDelivered 
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Supported parameters

All attributes of the Microsoft
Dynamics CRM campaign activity
(including custom attributes).

The number of attributes can be different based on the
customization of your Microsoft Dynamics CRM
implementation.

Note:
For a full list of attributes for each entity, refer to the Microsoft Dynamics CRM Entity reference
available at http://YourMSCRMServer/sdk/list.aspx.

MSCRM.CampaignResponse.ActivityDelivered
Description
Microsoft Dynamics CRM Plug-in triggers this event to the Call Center Elite Multichannel Desktop
Rules Plug-in when a Microsoft Dynamics CRM campaign response activity is delivered to the
desktop.

All attributes (including custom attributes) of the Microsoft Dynamics CRM campaign response
activity are returned and made available.

Syntax
When MSCRM.CampaignResponse.ActivityDelivered 

Supported parameters

All attributes of the Microsoft
Dynamics CRM campaign response
activity (including custom attributes).

The number of attributes can be different based on the
customization of your Microsoft Dynamics CRM
implementation.

Note:
For a full list of attributes for each entity, refer to the Microsoft Dynamics CRM Entity reference
available at http://YourMSCRMServer/sdk/list.aspx.

MSCRM.Case.IncidentDelivered
Description
Microsoft Dynamics CRM Plug-in fires this event to the Call Center Elite Multichannel Desktop Rules
Plug-in when a Microsoft Dynamics CRM case incident is delivered to the desktop.

All attributes (including custom attributes) of the Microsoft Dynamics CRM case incident are
returned and made available.

Syntax
When MSCRM.Case.IncidentDelivered 

Supported parameters

All attributes of the Microsoft
Dynamics CRM case incident
(including custom attributes).

The number of attributes can be different based on the
customization of your Microsoft Dynamics CRM
implementation.
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Note:
For a full list of attributes for each entity, refer to the Microsoft Dynamics CRM Entity reference
available at http://YourMSCRMServer/sdk/list.aspx.

MSCRM.Email.ActivityDelivered
Description
Microsoft Dynamics CRM Plug-in fires this event to the Call Center Elite Multichannel Desktop Rules
Plug-in when a Microsoft Dynamics CRM email activity is delivered to the desktop.

All attributes (including custom attributes) of the Microsoft Dynamics CRM email activity are returned
and made available.

Syntax
When MSCRM.Email.ActivityDelivered 

Supported parameters

All attributes of the Microsoft
Dynamics CRM email activity
(including custom attributes).

The number of attributes can be different based on the
customization of your Microsoft Dynamics CRM
implementation.

Note:
For a full list of attributes for each entity, refer to the Microsoft Dynamics CRM Entity reference
available at http://YourMSCRMServer/sdk/list.aspx.

MSCRM.Fax.ActivityDelivered
Description
Microsoft Dynamics CRM Plug-in fires this event to the Call Center Elite Multichannel Desktop Rules
Plug-in when a Microsoft Dynamics CRM fax activity is delivered to the desktop.

All attributes (including custom attributes) of the Microsoft Dynamics CRM fax activity are returned
and made available.

Syntax
When MSCRM.Fax.ActivityDelivered 

Supported parameters

All attributes of the Microsoft
Dynamics CRM fax activity
(including custom attributes).

The number of attributes can be different based on the
customization of your Microsoft Dynamics CRM
implementation.

Note:
For a full list of attributes for each entity, refer to the Microsoft Dynamics CRM Entity reference
available at http://YourMSCRMServer/sdk/list.aspx.
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MSCRM.Letter.ActivityDelivered
Description
Microsoft Dynamics CRM Plug-in fires this event to the Call Center Elite Multichannel Desktop Rules
Plug-in when a Microsoft Dynamics CRM letter activity is delivered to the desktop.

All attributes (including custom attributes) of the Microsoft Dynamics CRM letter activity are returned
and made available.

Syntax
When MSCRM.Letter.ActivityDelivered 

Supported parameters

All attributes of the Microsoft
Dynamics CRM letter activity
(including custom attributes).

The number of attributes can be different based on the
customization of your Microsoft Dynamics CRM
implementation.

Note:
For a full list of attributes for each entity, refer to the Microsoft Dynamics CRM Entity reference
available at http://YourMSCRMServer/sdk/list.aspx.

MSCRM.PhoneCall.ActivityDelivered
Description
Microsoft Dynamics CRM Plug-in fires this event to the Call Center Elite Multichannel Desktop Rules
Plug-in when a Microsoft Dynamics CRM phone call activity is delivered to the desktop.

All attributes (including custom attributes) of the Microsoft Dynamics CRM phone call activity are
returned and made available.

Syntax
When MSCRM.PhoneCall.ActivityDelivered 

Supported parameters

All attributes of the Microsoft
Dynamics CRM phone call activity
(including custom attributes).

The number of attributes can be different based on the
customization of your Microsoft Dynamics CRM
implementation.

Note:
For a full list of attributes for each entity, refer to the Microsoft Dynamics CRM Entity reference
available at http://YourMSCRMServer/sdk/list.aspx.

MSCRM.ServiceActivity.ActivityDelivered
Description
Microsoft Dynamics CRM Plug-in fires this event to the Call Center Elite Multichannel Desktop Rules
Plug-in when a Microsoft Dynamics CRM service activity is delivered to the desktop.
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All attributes (including custom attributes) of the Microsoft Dynamics CRM service activity are
returned and made available.

Syntax
When MSCRM.ServiceActivity.ActivityDelivered

Supported parameters

All attributes of the Microsoft
Dynamics CRM service activity
(including custom attributes).

The number of attributes can be different based on the
customization of your Microsoft Dynamics CRM
implementation.

Note:
For a full list of attributes for each entity, refer to the Microsoft Dynamics CRM Entity reference
available at http://YourMSCRMServer/sdk/list.aspx.

MSCRM.Task.ActivityDelivered
Description
Microsoft Dynamics CRM Plug-in fires this event to the Call Center Elite Multichannel Desktop Rules
Plug-in when a Microsoft Dynamics CRM task activity is delivered to the desktop.

All attributes (including custom attributes) of the Microsoft Dynamics CRM task activity are returned
and made available.

Syntax
When MSCRM.Task.ActivityDelivered 

Supported parameters

All attributes of the Microsoft
Dynamics CRM task activity
(including custom attributes).

The number of attributes can be different based on the
customization of your Microsoft Dynamics CRM
implementation.

Note:
For a full list of attributes for each entity, refer to the Microsoft Dynamics CRM Entity reference
available at http://YourMSCRMServer/sdk/list.aspx.

Supported Return Events
MSCRM.Create

Description
This event is sent from the Call Center Elite Multichannel Desktop Rules Plug-in and received by
Microsoft Dynamics CRM Plug-in. It instructs Microsoft Dynamics CRM Plug-in to create a new
instance of a Microsoft Dynamics CRM entity.

The result can be accessed when Microsoft Dynamics CRM Plug-in finishes creating the entity and
triggers the MSCRM.CreateCompleted event.

Microsoft Dynamics CRM Plug-in
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Syntax
Do ReturnEvent MSCRM.Create, entity=account, attributes=telephone1|name, values=%CallerDN
%|NewAccount, invokeId=Rule1 Then Continue 

Supported parameters

entity Microsoft Dynamics CRM entity instance to create.

attributes A pipe delimited string of attributes to be set for this entity instance.

For a complete list of attributes for each Microsoft Dynamics CRM entity, refer to the
MSCRM SDK or navigate to http://<yourservername>/sdk/list.aspx.

The following example adds three attributes: telephone1, telephone2 and telephone3
which are valid attributes for the contact entity.

For example, telephone1|telephone2|telephone3

values A pipe delimited string of attribute values to be set for this entity instance.

Must match the number of attributes specified in "Create Attributes" parameter.

The following example sets values for the three attributes telephone1, telephone2 and
telephone3

For example, +64(9)4770641|+64(21)409965|+64(272)066082

invokeID This invoke id is provided for additional filtering if required, in case rules start to get
complicated and overlap each other. Microsoft Dynamics CRM Rules Event
MSCRM.CreateCompleted includes this parameter.

MSCRM.Lookup
Description
This event is sent from the Call Center Elite Multichannel Desktop Rules Plug-in and received by
Microsoft Dynamics CRM Plug-in. It instructs Microsoft Dynamics CRM Plug-in to query the
Microsoft Dynamics CRM's database adhering to the MSCRM SDK API.

The result of this lookup can be accessed when Microsoft Dynamics CRM Plug-in completes its look
up and triggers the MSCRM.LookupCompleted event.

Syntax
Do ReturnEvent MSCRM.Lookup, entity=contact, attributes=telephone1|telephone2|
mobilephone, value=%CallerDN%,condition=1, returnMultiples=true, InvokeId=Rule1 Then 
Continue 

Supported parameters

entity Microsoft Dynamics CRM entity to look up.

attributes A pipe delimited string of attributes to lookup.

For a complete list of attributes for each Microsoft Dynamics CRM entity, refer
to the MSCRM SDK or navigate to http://<yourservername>/sdk/list.aspx.
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The following example looks up three attributes telephone1, telephone2 and
telephone3 which are valid attributes for the contact entity.

For example, telephone1|telephone2|telephone3

values The value to lookup. Can be fixed, will typically be one of parameters received
from Microsoft Dynamics CRM trigger events.

condition Specifies the search condition, available options are: 0=Exact, 1=LIKE

returnMultiples Specifies whether MSCRM.LookupCompleted returns pipe delimited string of
matches when multiple matches are found. If disabled only the first match will
be returned.

This is to cater for external applications who cannot understand pipe delimited
string of ids when external applications are triggered on
MSCRM.LookupCompleted.

false=Disabled, true=Enabled

invokeID This invoke id is provided for additional filtering if required, in case rules start to
get complicated and overlap each other. Microsoft Dynamics CRM Rules Event
MSCRM.CreateCompleted includes this parameter.

MSCRM.Retrieve
Description
This event is sent from the Call Center Elite Multichannel Desktop Rules Plug-in and received by
Microsoft Dynamics CRM Plug-in. It instructs Microsoft Dynamics CRM Plug-in to retrieve a
Microsoft Dynamics CRM entity instance.

The result of this retrieve can be accessed when Microsoft Dynamics CRM Plug-in completes its
retrieve and triggers the MSCRM.RetrieveCompleted event.

Syntax
Do ReturnEvent MSCRM.Retrieve, entity=contact, id=9A24C8F0-A258-DB11-BD2E-000C2928CAD3, 
InvokeId=Rule1 Then Continue 

Supported parameters

entity Microsoft Dynamics CRM entity to retrieve.

ID The id of the entity instance to retrieve.

invokeID This invoke id is provided for additional filtering if required, incase rules start to get
complicated and overlap each other. Microsoft Dynamics CRM Rules Event
MSCRM.RetrieveCompleted includes this parameter.

Microsoft Dynamics CRM Plug-in
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MSCRM.Screenpop
Description
This event is sent from the Call Center Elite Multichannel Desktop Rules Plug-in and received by
Microsoft Dynamics CRM Plug-in. It instructs Microsoft Dynamics CRM Plug-in to screen pop a
Microsoft CRM entity instance.

Syntax
Do ReturnEvent MSCRM.Screenpop, entity=contact, id=9A24C8F0-A258-DB11-BD2E-000C2928CAD3, 
bringToFront=true Then Continue 

Supported parameters

entity Microsoft CRM entity to screen pop.

ID The id of the entity instance to screen pop.

bringToFront True or False. Whether to bring the screen popped document window to the front
or not.

Call Routing Server to Plug-in
The following events will be sent from the Call Routing Server to the plug-in.

For parameter descriptions, see the Avaya Application Enablement Services TSAPI for Avaya
Communication Manager Programmer's Reference Guide.

Related links
CallDelivered on page 138
CallEstablished on page 140
ConnectionCleared on page 141
CallCleared on page 141
RouteRequest on page 142
RouteEnd on page 142
RouteUsed on page 143
TServerLinkStatus on page 143

CallDelivered
This event is fired when the call is delivered to a monitored VDN. This event will fire whenever the
Call Routing Server receives the cstaCallDelivered event from the Telephony Server.

The following parameters will be passed with the CallDelivered event.

• VDN
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• CallID

• CallingDevice

• CalledDevice

• AlertingDevice

• LastRedirectionDevice

• Cause

• DeliveredType

• Split

• UserEnteredCode

• UUI

• TrunkGroup

• TrunkGroupMember

• UCID

• LAIType

• LAIPriority

• LAIHours

• LAIMinutes

• LAISeconds

• LAISourceVDN

• OCICallingDevice

• OCICalledDevice

• OCITrunkMember

• OCITrunkGroup

• OCIUserEnteredCode

• OCIUUI

• OCIUCID

• OCILAIType

• OCILAIPriority

• OCILAIHours

• OCILAIMinutes

• OCILAISeconds

• OCILAISourceVDN

Call Routing Server to Plug-in
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Related links
Call Routing Server to Plug-in on page 138

CallEstablished
This event is fired when the call is answered. This will be triggered by receiving the cstaEstablished
event from the Telephony Server.

The following parameters will be passed with the CallEstabished event.

• VDN

• CallID

• AnsweringDevice

• CallingDevice

• CalledDevice

• Cause

• LastRedirectionDevice

• Split

• UserEnteredCode

• UUI

• TrunkGroup

• TrunkGroupMember

• UCID

• LAIType

• LAIPriority

• LAIHours

• LAIMinutes

• LAISeconds

• LAISourceVDN

• OCICallingDevice

• OCICalledDevice

• OCITrunkMember

• OCITrunkGroup

• OCIUserEnteredCode

• OCIUUI

• OCIUCID

Plug-ins
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• OCILAIType

• OCILAIPriority

• OCILAIHours

• OCILAIMinutes

• OCILAISeconds

• OCILAISourceVDN

Related links
Call Routing Server to Plug-in on page 138

ConnectionCleared
This event is mapped directly from the cstaConnectionCleared event received from the Telephony
Server.

The following parameters will be passed with the ConnectionCleared event.

• VDN

• CallID

• ReleasingDevice

• Cause

Related links
Call Routing Server to Plug-in on page 138

CallCleared
This event is mapped directly from the cstaCallCleared event received from the Telephony Server.

The following parameters will be passed with the CallCleared event.

• VDN

• CallID

• Cause

• Reason

Related links
Call Routing Server to Plug-in on page 138

Call Routing Server to Plug-in

July 2016 Avaya Aura® Call Center Elite Multichannel Desktop User Guide 141
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Aura® Call Center Elite Multichannel Desktop User Guide


RouteRequest
This event is mapped directly from the cstaRouteRequest event received from the Telephony
Server.

The following parameters will be passed with the RouteRequest event.

• RouteRegisterReqID

• RouteCrossRefID

• CurrentRoute

• CallID

• CallingDevice

• TrunkGroup

• TrunkGroupMember

• UserEnteredCode

• LAIType

• LAIPriority

• LAIHours

• LAIMinutes

• LAISeconds

• LAISourceVDN

• UUI

• UCID

• VDN

Related links
Call Routing Server to Plug-in on page 138

RouteEnd
This event is mapped directly from the cstaRouteEnded event received from the Telephony Server.

The following parameters will be passed with the RouteEnd event.

• RouteRegisterReqID

• RoutingCrossRefID

• ErrorValue

• VDN

Plug-ins
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Related links
Call Routing Server to Plug-in on page 138

RouteUsed
This event is mapped directly from the cstaRouteUsed event received from the Telephony Server.

The following parameters will be passed with the RouteUsedEvent:

• EventName

• Comma-Separated Event Arguments

Related links
Call Routing Server to Plug-in on page 138

TServerLinkStatus
This event is broadcasted to all extensions when the Telephony Server link status is changed.

The following parameters will be passed with the TServerLinkStatus event.

• LinkStatus: Two values are Up and Down.

• IsPrimaryLink: The values are True and False. This parameter indicates whether this link is the
primary link or the secondary link.

Related links
Call Routing Server to Plug-in on page 138

Plug-in to Call Routing Server
The plug-in instructs Call Routing Server to perform tasks by use of a fixed command set.

In the following commands there is a mixture of command parameters that are mandatory (M) and
those that are optional (O). If a mandatory parameter is missing, the command request will be
ignored.

For parameter descriptions, refer to the Avaya Application Enablement Services TSAPI for Avaya
Communication Manager Programmer's Reference.

Related links
RouteSelect on page 144
RouteEnd on page 144
ClearCall on page 144
ClearConnection on page 145

Plug-in to Call Routing Server
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RouteSelect
Received from the Call Center Elite Multichannel plug-in, this event instructs the Call Routing Server
to direct a call to the specified destination. This event will expect the following parameters:

• RouteRegisterReqID (M)

• RoutingCrossRefID (M)

• RouteSelected (M)

• RouteUsedReq (O)

• CallingDevice (O)

• DirectAgentCallSplit (O)

• UserProvidedCode (O)

• UUI (O)

Related links
Plug-in to Call Routing Server on page 143

RouteEnd
Received from the Call Center Elite Multichannel plug-in, this event instructs the Call Routing Server
to end routing association on a specific call. This event will expect the following parameters:

• RouteRegisterReqID (M)

• RoutingCrossRefID (M)

• ErrorValue (M)

Related links
Plug-in to Call Routing Server on page 143

ClearCall
Received from the Call Center Elite Multichannel plug-in, this instructs the Call Routing Server to
clear the call. The following parameters will be received with the request:

• CallID (M): The Avaya Aura® Communication Manager that represents the call to be cleared.

Related links
Plug-in to Call Routing Server on page 143
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ClearConnection
Received from the Call Center Elite Multichannel plug-in, this instructs the Call Routing Server to
clear a party from the call. The following parameters will be received with the request:

• CallID (M): The Avaya Aura® Communication Manager that represents the call.

• Device (M): The device to be dropped from the call.

• UUI (O): Any user-to-user information that should be inserted with the clear connection request
when it is sent to the Avaya Telephony Server.

Related links
Plug-in to Call Routing Server on page 143

Plug-in to Call Routing Server
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Appendix C: Media Proxy

Media Proxy is a bridge component that manages the connections between Media Director and any
number of client applications running on the same computer.

Running as a Windows service in the background, Media Proxy:

• Reduces network traffic when multiple client applications on one machine need to connect to
the Media Director.

• Automatically connects to the Media Director when it restarts (client applications do not need to
re-connect to the Media Director when it restarts).

• Allows users to use Call Center Elite Multichannel Desktop when building client applications.

Note:

The performance of Call Center Elite Multichannel reduces when you run Media Proxy on the
Server end with multiple Desktops connected to it.

Related links
Client Applications on page 146
.Net Remoting Connection on page 147
Starting Call Center Elite Multichannel service on page 147

Client Applications
Media Proxy allows multiple client applications to connect to more than one Media Director. To
achieve this, client applications need to provide:

• The Media Director's IP address and port number.

• The agent's voice station DN.

• The type of work item the client application needs to receive.

Related links
Media Proxy on page 146
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.Net Remoting Connection
All Call Center Elite Multichannel Desktop applications and services that use .Net remoting,
automatically use a configuration file, in this case ASMediaProxyService.exe.config, to
control their remoting connection. The file, which should not be changed, specifies the gtcp channel
and default port number.

ASMediaProxyService.exe.config also specifies and controls the level of error logging.

Note:

Desktops can also connect to Servers using a secure connection over .Net Remoting. For
information about secure connection, see Administering Avaya Aura® Call Center Elite
Multichannel.

Related links
Media Proxy on page 146
Error logging on page 18

Starting Call Center Elite Multichannel service
About this task
Use this procedure to start Call Center Elite Multichannel service.

Procedure
1. Click the Start button on the Windows Taskbar and select Control Panel from the pop-up

menu.

2. Click Administrative Tools.

3. Click Services.

4. Right-click a Call Center Elite Multichannel service and select Start from the pop-up menu.

• AS Application Management Director
• AS Call Routing Server
• AS Email Media Store
• AS IDS MultiMedia
• AS IDS View
• AS IDS Voice
• AS IVR Server
• AS Media Proxy Service
• AS Preview Contact Media Store
• AS Short Message Service Gateway

.Net Remoting Connection
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• AS Simple Messaging Media Store

• AS Web Chat Gateway

• AS XML Server

Related links
Media Proxy on page 146

Media Proxy
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Appendix D: Troubleshooting

The troubleshooting section provides tips, Frequently Asked Questions (FAQs), and answers for
some problems that you might face when using Call Center Elite Multichannel Desktop.

Note:

For error and warning messages, the system displays the troubleshooting information in the
Status Bar Details window.

In the Status Bar Details window, the information is added in a chronological order. You can
select a message to read the details and troubleshooting information.

Station monitoring fails
Desktop fails to monitor a station. The system displays a red cross mark on the Station DN icon in
the status bar of Desktop.

This problem occurs because Desktop is unable to connect to the XML server to make a successful
station monitoring request.

Solution
Procedure

1. Run the XMLServerTest.exe file from the default directory: <CCEM_INSTALL_DIR>
\Avaya Aura CC Elite Multichannel\Desktop\CC Elite Multichannel
Desktop\XML Server Test.

2. Run the TSTEST32.exe file from the default directory: <CCEM_INSTALL_DIR>\AE
Services\TSAPI Client\Program.

• If the TSAPI test fails, check Application Enablement Services or Communication
Manager for a problem.

• If the TSAPI test passes, but the XML server test fails, check the following logs of Call
Center Elite Multichannel for a problem:

- Desktop logs: Enable Telephony section trace and error logging.
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- XML server logs: Set the log level to 1.

- TSSPY trace logs.

3. Check if you are using a valid station and you are logged in to the soft phone or a hard
phone using that station.

Agent is unable to log in to Desktop
After starting Desktop, an agent is unable to log in to Desktop.

This problem occurs because an agent specifies invalid login credentials or tries to log in to a station
that the system does not monitor.

Solution
Procedure

1. Check and ensure the following:

• The system monitors the station.

• The agent has entered valid login credentials.

• The agent is not already logged in to another station.

2. Check the following logs:

• Desktop logs: Enable Telephony section trace and error logging.

• XML server logs: Set the log level to 1.

• TSSPY trace logs.

Agent does not receive the associated multimedia work
item

Agent does not receive the associated multimedia work item -
Problem 1

Agent receives a phantom call but does not receive the associated multimedia work item such as
Email, Chat, SMS, or Preview Contact.

This problem occurs because Desktop is unable to connect to media stores, such as Email, Simple
Messaging, or Preview Contact, through Media Director.

Troubleshooting
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Solution
Procedure

1. Check and ensure the following:

• Desktop successfully connects to Media Proxy.

• Media Director has information about all configured media stores.

• The logged in agent is successfully registered with Media Director. Check the agent
details in the Media Client node of Media Director.

• FQDN, which Desktop uses to connect to media stores, resolves the correct IP address of
the media store server.

2. Check the following logs along with the configuration file:

• Desktop logs.

• Media Director logs.

• Logs files of the media store that has a problem.

Agent does not receive the associated multimedia work item -
Problem 2

Agent receives a phantom call but does not receive the associated multimedia work item such as
Email, Chat, SMS, or Preview Contact.

Solution
Procedure

1. Ensure that you do not monitor voice VDNs in multimedia queues.

2. Ensure that you do not use call diversion techniques for multimedia VDNs. An example of
call diversion techniques is Automatic Call Forward.

Agent receives a phantom call but does not receive the
associated CRM work item

Condition
Agent receives a phantom call but does not receive the work item associated with the phantom call
when CRM is configured.

Cause
This problem occurs when the time on the Call Center Elite Multichannel Desktop, Call Center Elite
Multichannel server, and CRM server are not synchronized.

Agent receives a phantom call but does not receive the associated CRM work item
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Solution
1. Synchronize the time on the Call Center Elite Multichannel Desktop, Call Center Elite

Multichannel server, and CRM server.
2. Restart the PCMS service.

Presence and Wallboard do not display statistics
In Desktop, Presence and Wallboard do not display the statistics and telephonic activities of agents.

This problem occurs because the IDS client is unable to connect to the IDS View server.

Solution
Procedure

1. Check and ensure the following:

• You have specified the correct IDS View server configuration details in Desktop. You can
find the details on the IDS View Client tab.

• You have deselected the Receive by multicast option in Desktop if multicast is disabled
in the network. You can find this option on the IDS View Client tab.

• The IDS View and IDS Voice and Presence services are successfully running.

2. Check the following logs:

• IDS View Client trace log from Desktop.
• IDS View server log.
• IDS Voice and Presence log.

Licensing error messages
When you start Desktop, the system displays an error messages related to licensing.

Solution
Procedure
Check and ensure that the following events have not occurred:

• The license is not set up using Application Management Service.
• The license is a trial-only license and has expired.

Troubleshooting
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• The number of run-time licenses requested exceeds the total number of licenses purchased.

• The server running License Director or License Director itself is unavailable.

For more information about how Desktop interacts with License Director, see Administering Avaya
Aura® Call Center Elite Multichannel Guide.

Cut, Copy, and Paste options do not work in HTML editor
In HTML editor, the Cut, Copy, and Paste options do not work when you right-click context menus.

Solution
Disable the Enhanced Security option for Microsoft Internet Explorer.

For information about disabling the Enhanced Security option and its implications, see Microsoft
documentation on Microsoft website.

Cut, Copy, and Paste options do not work in HTML editor
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